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Capitulo 1: Introduccion

Storyboard Pro es un software completo de creacion de storyboard y animética para peliculas de animacidn,
series de TV, proyectos que combinen 2D/3D, producciones de accidn en vivo, videojuegos o eventos que
cuenta con funciones avanzadas.

En esta Guia de introduccién, aprendera los conceptos basicos del uso de las principales funciones de
Storyboard Pro, que le permitiran ponerse al dia rapidamente. Consulte la documentacion completa de Toon
Boom Storyboard Pro disponible en linea en docs.toonboom.com para aprender acerca de todas las

herramientas y opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/

Capitulo 2: Creacién de un proyecto

Capitulo 2: Creacion de un proyecto

Al abrir Storyboard Pro por primera vez, aparecen dos cuadros de didlogo. El primero proporciona vinculos
para:

e Aprender a utilizar Storyboard Pro.
» Conocer las novedades de esta versién de Storyboard Pro.

 Participar en el foro de Toon Boom, donde puede cambiar informacidn con otros usuarios de Storyboard
Pro, realizar preguntas y obtener respuestas.

What's New

Al cerrar la primera pantalla de bienvenida, se mostrara la segunda, en la que se pueden crear y abrir
proyectos.
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Abrirun
proyecto
Creary reciente
nombrar un
Agregaro
eliminarun
valor
Establecer la predefinido de
configuracién resolucion de
Open Project...
Ver tutoriales envideo Acceder a la documentacidn Examinary abrir
de Storyboard Pro de Storyboard Pro un proyecto
\ ' 4
_Q- CONSEJO
’ N

Una vez en la ventana principal de la aplicacién, puede volver a la pantalla de bienvenida
seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de bienvenida) en el
menu superior.

Creacion de un proyecto desde la pantalla de bienvenida

1. Enelcampo Project Name (Nombre de proyecto), escriba el nombre del proyecto. Este nombre se
usard para nombrar la carpeta del proyecto y el archivo principal del proyecto.

2. Enel campo Project Title (Titulo del proyecto), escriba el nombre del titulo del proyecto. De forma
predeterminada, este campo ya estara relleno con lo que escribié en el campo Project Name
(Nombre del proyecto).

3. Sidesea que el proyecto tenga un subtitulo, escribalo en el campo Project Subtitle (Subtitulo del
proyecto). Esto no es obligatorio.

4. En el menu desplegable Camera Size (Tamafio de cdmara), seleccione la resoluciéon del proyecto.
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Width

Height:

El ancho, la altura, los fotogramas por segundo y el campo de vision se actualizan
automaticamente en funcion de la seleccidn del tamafio de la cdmara.

5. En el menu desplegable Colour Space (Espacio de color), seleccione un espacio de color para su
proyecto.

6. Haga clic en Create Project (Crear proyecto).
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Capitulo 3: Acerca de la interfaz de usuario

Al iniciar Storyboard Pro por primera vez, se presenta el espacio de trabajo predeterminado. Contiene todos
los elementos principales que necesita para la creacién de un storyboard.

Barra de herramientas
I Ment superior l [ Vista de escena I de storyboard [ Barra de herramientas de reproduccién ]
I 1

Barra de
herramientas
de

Vista de
panel

]
Barra de -
herramientas ] -
B Vista de
de capa o
L imagenes
en
miniatura
Vistas

La interfaz de usuario de Storyboard Pro se compone principalmente de vistas, que son secciones del espacio
de trabajo con un propdsito especifico y un conjunto de funciones. Cada vista tiene una pestafia encima y se
puede anclar en la ventana de aplicacion principal o hacerla flotar sobre ella en su propia ventana.

Adicidn de una vista al espacio de trabajo como una pestana

1. En la esquina superior derecha de una vista existente, haga clic en el botén #= Add View (Agregar

vista).
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Panel

Tool Properties
To

Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestafna en la seccidn del espacio de trabajo donde la agregd.

10



Guia de introduccién de Storyboard Pro 24

Adicion de una vista a la zona de trabajo como una ventana

1. Abra el mend Windows (Ventanas).
2. Enel mend Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecera como una nueva ventana sobre la ventana de la aplicacién principal de
Storyboard Pro.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre la vista flotante por la pestaia y realice una de las siguientes acciones:
» Coloque la ventana sobre otra pestaia para agregarla a ese conjunto de pestanas.

¢ Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse
al borde de una vista, aparece un rectangulo cian que indica dénde se anclara la vista.

Vistas de escena y de camara

La vista de escena es la vista principal de Storyboard Pro. Se utiliza para ver y editar el panel seleccionado.
Puede dibujar en capas del panel, manipular elementos en él, y crear y visualizar movimientos de camara.

11
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Pt
n o ' ‘: :, -
Modo de imégenes Fotograma de I
en miniatura la cidmara [ Herramienta seleccionada ] [ Selector de color
[Cuadrl’cula] [Capa actual ]
[ Zona segura de accién ] [Selector de factor de zoom ]
[ Zona segura de titulo] I Modo de punto de vista I
Zona segura 4:3 | [Consultar seleccionados I
Zona 4:3_] [Restablecer rotacion ]

[ Madscara de camara l [Restablecer vista ]
[ Cuadricula de proporciones ] [ Ruta de camara completa ]
[ Mostrar guias de alineacion ] [ Etiqueta de camara ]

[ Mostrar superposiciones I

La vista de cdmara es muy parecida a la vista de escena y no es necesario usarla si no pretende trabajar en 2D.
Sin embargo, si tiene pensado trabajar con modelos 3D, para colocar los elementos a distintas distancias de la
camara o rotar capas en 3D, la diferencia es importante: al trabajar en 3D, la vista de escena permite ver la
escena desde cualquier punto de vista en el espacio 3D, mientras que la vista de cdmara siempre muestra una
vista previa de la escena desde el punto de vista de la lente de la cdmara, lo que indica que representa con

precision lo que aparecera al exportar el storyboard.

Panel de capas

El panel de capas aparece en una seccidn situada a la derecha tanto de la vista de escena como de la de
camara. Permite agregar, eliminar, duplicar, agrupar, reordenar, ocultar, mostrar, bloquear o desbloquear
capas, habilitar o deshabilitar animacion en capas, cambiar la opacidad de una capa y seleccionar en qué capa
se debe dibujar, manipular o animar.

12
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[ Mostrar/ocultar panel Opacidad de la capa seleccionada I

ol s

Grupo

[ Mostrar/ocultar capa

[ Bloguear/desbloquear capa

Habilitar/deshabilitar

animacion de capas

[ Agregar capa de vectorl [ Capas seleccionadas eliminadasl

[ Agregar capa de mapa de bitsl [Agrupar capas seleccionadas I

[ Duplicar capas seleccionadas I

Vista de imagenes en miniatura

La vista de imagenes en miniatura muestra todos los paneles del storyboard en orden cronoldgico de izquierda
a derecha. Mediante esta vista, puede desplazarse por el storyboard, reorganizar paneles y escenas, y
seleccionar qué panel se debe mostrar en las vistas de escena o de camara.

Numero de panel

Numero de paneles en escena I

[ NUmero de escena

[ Controlador de arrastrar y colocar

[ Expandir/contraer escena [Longitud de panel I [ Bloquear/desbloquear capa I [ Mostrar/ocultar capal

Thumbnail: Expandir todas

Contraer todas las
escenas

Capas en el panel

[ Escena con 1 panell [ Mueva secuencia I [ Escena con 2 paneles I

Vista de linea de tiempo

La vista de linea de tiempo es la vista que se debe usar en lugar de la de imagenes en miniatura cuando desee
crear una animatica. Una animatica es un video basado en el storyboard, en el que cada panel esta

13



Capitulo 3: Acerca de la interfaz de usuario

sincronizado para que aparezca aproximadamente durante la accidn que representa, y en el cual se animan los
movimientos de la cadmara, para servir como base para el tiempo en la pelicula. Aligual que la vista de
imagenes en miniatura, la vista de linea de tiempo le permite crear y gestionar paneles y escenas. También le
permite, entre otras cosas, decidir cuanto tiempo tardan cada escena y cada panel en la animatica, animar los
movimientos de camara, animar capas y agregar clips de sonido, imagenes y videos en la animatica.

| Nuevo acto [ Movimiento de cdmara l [ Cabezal de reproduccic’m]

[ Escena I

[ Mueva secuencia I

[ Cddigo de tiempo actual

[ Duracién de proyecto

[ Pista de animacién de camara

Pistasde
l Pista del storyboard = video y
Secuencia actual storyboard

[ Pista de animacién de capa

Pistas de
- -
audio

Control deslizante de zoom
de linea de tiempo

Clip de sonido

[Restablecer zoom I [ Animacidn de capal

Sobrescribir clips

[ Modo de edicién de animatica I

’ Menu de linea de tiempo I

Vista de panel

La vista de panel muestra la informacion basica sobre el panel seleccionado. También permite ver y editar
cuadros de texto en el panel actual, asi como agregar bocetos o anotaciones de voz al panel.

14
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Informacién

I

del panel
actual

Informacién
. x ™
de seleccion

Barra de
herramientas
de anotaciones

Campos de
cuadro de
texto

Reordenar campo de cuadro de texto

[ AnDtacic’m] [ Grabar nueva anotacion ]

[ Reproducir anotacion ] Eliminar anotacién

Anotacion anterior

[ Numero de anotacidn actual l

[ Cantidad de anotaciones en el panel I

Cambiar formato de texto ]

Maximizar/minimizar/restaurar panel de cuadro de texto ]

' Tipo de cuadro de texto

Vista de storyboard

Menu de cuadros de texto ]

Cambiar tamano de panel de cuadro de texto

La vista de storyboard muestra informacidn basica sobre el proyecto. También permite escribir, importar, ver y

editar el guion

proyecto

Informacién de
-

del storyboard.

guion

Editor de ||

oard

Tool Proper

Cambiar formato de texto I

Maximizar/minimizar/restaurar panel de guion I

Ment de cuadros de texto I

15
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Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones disponibles para la herramienta
seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de herramientas, la
vista de propiedades de la herramienta se actualiza para mostrar sus opciones disponibles.

Library | 1%

Barras de herramientas

La interfaz de Storyboard Pro contiene barras de herramientas que proporcionan acceso rapido a muchas
herramientas Utiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas mas importantes de Storyboard Pro son las de herramientas, storyboard y
reproduccion.
Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en
Storyboard Pro. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde
izquierdo de la ventana de la aplicacion.

16
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Una flecha en la esquina indica que
hay mds herramientas disponibles
enun menl emergente

|

Seleccionar

[ Editor de contornos

# Centerline Edito

M Edit Gradient/

Borrador

w Paint

w Paint Unpainted

Cuentagotas

[ Transformacién de capas

[ Recalcular fotogramas

Mantener tamano

[ Crear capa en superficie

Barra de herramientas de storyboard

La barra de herramientas Storyboard contiene todos los comandos bdsicos relacionados con la adicién y
eliminacion de paneles, escenas y transiciones, asi como el cambio entre las zonas de trabajo 2D y 3D.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la
interfaz.

[Eliminarpanelesseleccionados I

[ Mueva secuencia I [ Adicion inteligente de panel I

[ Habilitar 3D paraescena actuall

[ Restablecerescena a 2D|

Barra de herramientas de reproduccion

La barra de herramientas de reproduccién permite reproducir el storyboard. Al crear una animatica con
transiciones y sonido, puede reproducirla en tiempo real en la vista de escena para comprobar el tiempo.

En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en la parte superior de la
interfaz.

17
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[ Ir al primer fotograma de la seleccic’ml

[ Reproducir” Bucle I

[ Reproducir seleccic’ml

Menu superior

EL mend superior contiene la mayoria de los comandos disponibles en Storyboard Pro. Segun la vista en la que
esté trabajando y el elemento seleccionado, algunos comandos estan disponibles y otros no. EL menu superior
siempre estd situado en la parte superior de la interfaz.

File Edit View y board Layer Camera Clips Caption Tools Windows

Aqui se proporciona una breve introduccién sobre el objetivo de cada menu en el menu superior:

Descripcién

Permite acceder al cuadro de didlogo About (Acerca de nosotros) y también al cuadro de

Storyboard Pro 24 ., . , o .
dialogo Preferences (Preferencias). Este menu solo esta disponible en macOS.

Contiene elementos relacionados con la creacidn, el almacenamiento, la exportacidény la

File (Archivo) . .,
importacion de los proyectos.
Contiene comandos para cortar, copiar y pegar paneles o capas seleccionados, para
Edit (Editar) seleccionar paneles o capas, y para agrupar o desagrupar capas. En Windows, también es
la ubicacion del menu Preferences (Preferencias).
Permite panear, hacer zoom o rotar la vista actual, restablecerla a su punto de vista
View (Vista) predeterminado, y habilitar y deshabilitar determinados modos de vista, como el papel

cebolla o la mesa de luz.

. Permite reproducir y pausar la animatica, asi como desplazarse por los paneles y las
Play (Reproducir)
escenas del storyboard.

Permite gestionar las escenas, paneles y secuencias del proyecto, agregar transiciones,
Storyboard marcadores, instantaneas, y trazar los cambios realizados al proyecto. También es donde
se puede acceder al cuadro de didlogo Project Properties (Propiedades del proyecto).

L (Capa) Contiene una amplio conjunto de comandos para gestionar las capas de dibujo en el panel
ayer (Capa
v P actual, asi como los efectos que puede aplicar a las capas.

18
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Descripcién

i Contiene varios comandos para ayudar a gestionar la posicion y la animacién de la camara
Camera (Camara)
en una escena.

Clips Contiene comandos para editar y obtener vistas previas de video y clips de sonido.

Caption (Cuadro de . o
Permite agregar, eliminar, buscar y establecer el formato para los cuadros de texto.

texto)

Tools Permite seleccionar una de las herramientas de la barra de herramientas de herramientas,
(Herramientas) asi como ordenar, transformar y convertir las formas y lineas que componen los dibujos.
Windows Permite cambiar entre espacios de trabajo, administrar espacios de trabajo y acceder a las
(Ventanas) distintas vistas y barras de herramientas disponibles en Storyboard Pro.

Permite acceder a la documentacidn, los foros de Toon Boom, participar o dejar de

Help (Ayuda) participar en el programa de mejora de la experiencia del cliente, asi como comprobar si
e uda

PAY existen actualizaciones. En Windows, también puede acceder al cuadro de didlogo About

(Acerca de nosotros).

Desplazamiento por la interfaz

Con la ayuda de comandos de menu y los atajos de teclado, algunas vistas permiten navegar por su contenido
al acercarlos, alejarlos, panearlos y rotarlos. También puede restablecer el nivel de zoom, el paneo y el angulo
de rotacion de estas vistas segun sea necesario.

Los comandos de navegacion de la tabla que se muestra a continuacion se pueden utilizar en las siguientes
vistas, con algunas excepciones:

e Escena

e Camara

e Linea detiempo
» Funcidn, editor

e Lateral y superior

19
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_‘Q'. CONSEJO

Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para
Storyboard Pro en el cuadro de didlogo Keyboard Shortcuts (Atajos de teclado). Para acceder al
cuadro de didlogo Keyboard Shortcuts (Atajos de teclado):

* Windows : en el menu superior, seleccione Edit > Keyboard Shortcuts (Editar > Atajos de
teclado).

* macOS : En el menu superior, seleccione Storyboard Pro 24 > Keyboard Shortcuts
(Storyboard Pro 24 > Atajos de teclado).

Métodos de acceso

View > Zoom In (Ver > Acercar)

. Pulse 2
Zoom In (Acercar) Acerca la vista.
Gire la rueda del ratén hacia arriba (excepto en las vistas de linea
de tiempo y de vista).
View > Zoom Out (Ver > Alejar)
. . . Pulse 1
Zoom Out (Alejar) Aleja la vista.

Gire la rueda del ratdn hacia abajo (excepto en las vistas de linea
de tiempo y de vista).

Zoom In o Zoom Gire la rueda central del ratén hacia arriba o hacia abajo.

Acerca o aleja la

Out (Acercar o Mantenga pulsada la barra espaciadora y la rueda central del

. vista.
Alejar) ratén mientras arrastra el ratén hacia arriba o hacia abajo.
Mueve la vista . . .,
. Mantenga pulsada la barra espaciadora y arrastre en la direccion
Pan (Panear) horizontal o .
. que desee panear la vista.
verticalmente.
Reset Pan Restablece el paneo View > Reset Pan (Ver > Restablecer paneo)
(Restablecer de vista a su posicién
paneo) predeterminada. Pulse Mayus + N.
View > Reset View (Ver > Restablecer vista)
Restablece la vista a
Reset View L, Pulse Mayus + M.
. Su posicion
(Restablecer vista) . , . . S
predeterminada. El botdn Reset View (Restablecer vista) @ en la parte inferior

de las vistas de escena y de cdmara.

20
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Comando

Accién

Métodos de acceso

Reset Rotation

Restablece la
rotacion de vista a su

View > Reset Rotation (Ver > Restablecer rotacién)

(Restablecer osicion
ICI ’
rotacidn) P . Pulse Mayus + X.
predeterminada.
Reset Zoom Restablece el zoom View > Reset Zoom (Ver > Restablecer zoom)
(Restablecer de vista a su posicion
zoom) predeterminada. Pulse Mayus + Z.

Rotate View (Rotar
vista)

Rota la vista ala
izquierdaoala
derecha.

Mientras mantiene pulsadas las teclas Ctrl + Alt (Windows) o
+ Alt (macOS), haga clic y arrastre el disco de rotacién para
rotarlo a la derecha o a la izquierda.

3D Rotate View
(Rotar vista 3D)

Rota la vista en
cualquier direccion.
Esta opcidn solo estd
disponible en la vista
de escena, si la
escena estd
habilitada para 3D.

Mientras mantiene pulsada la tecla Ctrl + Mayus (Windows) o
mayusculas + 8 (macOS), haga clic y arrastre la escena para
rotarla en cualquier direccion.

Rota la vista de

View > Rotate View CW (Ver > Rotar 30 der.)

Rotate 30 CW camara 30 grados a
(Rotar 30 der.) la derecha, como una Pulse V.
mesa de animacion.
Rota la vista de
Rotate 30 CCW camara 30 grados a View > Rotate View CCW (Ver > Rotar 30 izq.)
(Rotar 30 izq) la izquierda, como
otar 30 izq.
q una mesa de Putse C.
animacion.

Toggle Full Screen
(Alternar pantalla
completa)

Alterna entre hacer
que la ventana
principal de la
aplicacidn se muestre
en pantalla completa
y restaurarla a su
tamano original.

View > Toggle Full Screen (Ver > Alternar pantalla completa)

Ctrl + Alt + Mayus + F (Windows) o # + Alt + mayusculas + F
(macOS)

21
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Capitulo 4: Adicion de escenas y paneles

La estructura bdasica de un storyboard consta de escenas, y cada una de ellas estd compuesta por uno o varios
paneles. Un panel es un dibujo que representa una accién en el guion. Los paneles y las escenas de un
storyboard se ordenan en orden cronoldgico, de izquierda a derecha.

Un proyecto de animacion suele requerir la creacion de una nueva escena cada vez que se necesite cambiar el
layout. Esto significa que, por ejemplo, debe crear una nueva escena en el storyboard cada vez que un cambio
en el angulo de la cdmara requiera que se utilice un dibujo o representacion diferente del fondo, asi como cada
vez que el guion lleve la accidn a un entorno diferente.

Puede crear la estructura basica del storyboard agregando una escena para cada escena que requiera el guion
y, a continuacidén, agregando un panel para cada accidén en cada escena que se debe representar visualmente.

NOTA

En la terminologia de accidn en vivo, esta definicidon de escena se conoce como plano. Una escena
de accidn en vivo es en realidad una secuencia de planos que se producen en la misma
configuracion.

Si estd trabajando en un storyboard destinado a una pelicula de accidn en vivo, puede hacer que
Storyboard Pro utilice terminologia de accidn en vivo seleccionando la opcidn de estilo de
terminologia Live Action (Accidn en vivo) en la pestafia General del cuadro de didlogo Preferences
(Preferencias). Para facilitar la comprension, esta guia utilizara principalmente la terminologia de

animacion.

Creacion de escenas
Un nuevo proyecto contendrd una escena con un solo panel. La creacidon de una nueva escena siempre se

realizard automaticamente con un panel.

Adicion de una escena al storyboard

1. Seleccione cualquier panel de la ultima escena del storyboard.
2. Realice una de las siguientes acciones:

» En la barra de herramientas de storyboard, haga clic en el botédn £7 New Scene (Nueva

escena).
» Haga clic con el botén derecho en un panel y seleccione New Scene (Nueva escena).

* En el mend superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo >

Nueva escena).
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Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco.

Cada escena tiene un nimero asignado. Al crear una escena al final del proyecto, Storyboard Pro le asigna
automaticamente el nimero que aparece justo después del nimero de la Ultima escena. Si intenta insertar una
escena entre dos escenas existentes, se le pedira que indigue cémo debe nombrarse esta nueva escenay si las
escenas posteriores a la nueva deben volver a numerarse.

Insercion de una escena entre dos escenas existentes

1. Seleccione cualquier panel de la escena después del cual se deba insertar la nueva escena.
2. Realice una de las siguientes acciones:

» En la barra de herramientas de storyboard, haga clic en el botédn £7 New Scene (Nueva
escena).

* Haga clic con el botdn derecho en un panel y seleccione New Scene (Nueva escena).

» En el mend superior, seleccione Storyboard > New > New Scene (Storyboard > Nuevo >
Nueva escena).

Aparece el cuadro de didlogo Rename Scene (Cambiar nombre de escena).

Cancel
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3. Realice una de las siguientes acciones:

» Sidesea que la nueva escena tenga un sufijo para indicar que se inserto entre las escenas
existentes, no tiene que editar ninguno de los campos. EL campo New name (Nuevo nombre)
ya contiene el nombre de la escena seleccionada actualmente seguida de un sufijo de letra.
Por ejemplo, si ha intentado insertar una escena antes de las escenas 2 y 3, Storyboard Pro
nombrard la nueva escena 2_A de manera predeterminada.

» Sidesea que la escena tenga el nimero después del nimero de la escena seleccionada y
vuelva a numerar todas las escenas siguientes en consecuencia, introduzca este nimero en
el campo New Name (Nuevo nombre). Por ejemplo, si va a insertar una escena entre las
escenas 2 y 3, escriba 3 en el campo New Name (Nuevo nombre). A continuacion, en el
menu desplegable Renaming Rule for Subsequent Scene (Cambiar nombre de regla para
escena posterior), seleccione Renumber Scenes (Volver a numerar escenas).

4. Sitiene la intencidon de utilizar las mismas opciones cada vez que inserte una escena, active la
opcion Do not show this dialog automatically (No mostrar este cuadro de didlogo
automaticamente).

5. Haga clic en OK (Aceptar).

Después de la escena actual, se agrega una nueva escena que contiene un panel en blanco,
numerado de acuerdo con la configuracién seleccionada.

Creacion de paneles

Un panel se utiliza para representar visualmente una accidn en una escena. Debe agregar tantos paneles a una
escena como sea necesario para describir explicitamente cada accién de esa escena.

Adicion de un panel a una escena

1. En lavista de imdgenes en miniatura, seleccione el panel después del cual desea insertar un nuevo
panel.

=
=

2. Realice una de las siguientes acciones:
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* En la barra de herramientas de storyboard, haga clic en el boton New Panel (Nuevo
panel) ¥7.

* En el mend superior, seleccione Storyboard > New > New Panel

e PulseP.

Se agrega un nuevo panel al storyboard y forma parte de la misma escena que el panel actual.

=
=

Creacidon de secuencias

Una secuencia es una forma de agrupar escenas. Su uso es opcional, pero pueden ayudarle a organizar el
storyboard. Por ejemplo, puede utilizar secuencias para agrupar escenas que forman parte de la misma
configuracion.

Al comenzar a crear un storyboard, las escenas no formaran parte de ninguna secuencia de manera
predeterminada. Para utilizar secuencias en el proyecto, puede aplicar uno de los dos enfoques siguientes:

» Después de haber creado todas las escenas que deben formar parte de la primera secuencia, solo tiene
que usar el comando New Sequence (Nueva secuencia) para crear la préxima escena. Todas las
escenas que se encuentren en el proyecto se agruparan en la primera secuencia de este y, al final del
proyecto, se agregara una nueva escena que iniciara la segunda secuencia.

A partir de ese punto, puede utilizar el comando New Sequence (Nueva secuencia) cada vez que tenga
gue crear una escena que deba iniciar otra secuencia.

» Después de haber creado todas las escenas necesarias para el proyecto, puede dividir el storyboard en
secuencias seleccionando las escenas que deben formar parte de la misma secuencia, agrupandolas en

una nueva secuencia y repitiendo el proceso hasta que todas las escenas se encuentren en la secuencia
adecuada.
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Creacion de una nueva secuencia

1. Realice una de las siguientes acciones:

» En la barra de herramientas de storyboard, haga clic en el botdn New Sequence (Nueva
secuencia) & .

* En el menu superior, seleccione Storyboard > New > New Sequence (Storyboard > Nuevo >

Nueva secuencia).

Se ha agregado una nueva escena al proyecto y ahora es el punto de inicio de una nueva secuencia.

Si esta es la primera secuencia que agrega a un proyecto, todas las escenas anteriores se
combinaran en una secuencia independiente. Los marcadores de secuencia violetas también seran
visibles en las vistas de imagenes en miniatura y de linea de tiempo.

Creacion de una nueva secuencia a partir de una seleccion

1. En lavista de imdgenes en miniatura o de linea de tiempo, seleccione todas las escenas que desee
colocar en una nueva secuencia. Para ello, mantenga pulsada la tecla Mayus y haga clicen la
primera escena que debe formar parte de la nueva secuencia y, a continuacion, haga clicen la
ultima escena con el mismo propdsito. Con esta accidon se seleccionan todas las escenas situadas
entre las que ha hecho clic.

2. Realice una de las siguientes acciones:

a. En el mend superior, seleccione Storyboard > New > New Sequence from Selection
(Storyboard > Nuevo > Nueva secuencia de seleccion).
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b. Haga clic con el botén derecho en la seleccidn y, a continuacion, seleccione New Sequence
from Selection (Nueva secuencia de seleccién).

La seleccidn se convierte en una nueva secuencia.

Si esta es la primera secuencia que agrega al proyecto, todas las escenas anteriores a la seleccién
se agruparan en una secuencia independiente, y todas las escenas posteriores a la seleccion se
agruparan en otra secuencia. Los marcadores de secuencia violetas seran visibles en las vistas de

imagenes en miniatura y de linea de tiempo.

NOTA

Las secuencias deben incluir escenas completas. Si solo selecciona algunos de los paneles de

una escena, se incluird toda la escena en la secuencia.

Reordenacion de paneles

Puede reordenar paneles haciendo clic en el controlador de arrastrar y colocar :: situado en la esquina superior
izquierda del panel y, a continuacidn, arrastrando el panel entre los dos paneles donde desea que se muevan.
Aparecera una linea roja entre los dos paneles cerca del cursor del ratdn para indicar el lugar al que se movera

el panel.
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Si desea mover varios paneles a la vez, puede seleccionarlos vy, a continuacion, hacer clicy
arrastrar el controlador de arrastrar y colocar de cualquier panel de la seleccién. Para seleccionar
varios paneles en la vista de imagenes en miniatura, realice una de las siguientes acciones:

» Dibuje un rectangulo en la vista de imagenes en miniatura alrededor de todos los paneles que
desee seleccionar.

* Mientras mantiene pulsada la tecla Mayus, haga clic en el primer panel que desee agregar a la
seleccién y, a continuacion, en el dltimo panel que desee agregar. Todos los paneles
intermedios también se seleccionaran.

¢ Mientras mantiene pulsada la tecla Ctrl (Windows) 0 # (macQOS), haga clic en cada panel que
desee agregar a la seleccion.

Si mueve un panel al espacio situado entre dos escenas, puede colocar el panel en la escena anterior o
posterior a este espacio, o bien colocarlo en su propia escena nueva. El lugar donde terminara la escena
dependera de lo cerca que coloque el panel. La linea roja que aparece entre las dos escenas indicara si se
colocara en la escena anterior o posterior al espacio en el que se vaya a colocar el panel, o si se movera a su
propia escena nueva.

[ Elpanel se movera al final de la escena anterior El panel se movera al comienzo de la siguiente escena I

[ El panel se insertara en su propia escena I
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Capitulo 5: Adicion de un guion y de cuadros de texto

Antes de crear un storyboard, debe tener preparado un guion. Puede escribir el guion del proyecto
directamente en Storyboard Pro o puede importarlo desde un archivo. A continuacién, puede separar el guion
en cuadros de texto para cada uno de los paneles del storyboard para proporcionar al artista del storyboard la
informacion necesaria para dibujar el contenido de cada panel.

De forma predeterminada, cada panel puede almacenar cuatro tipos de cuadros de texto distintos: Dialogue
(Didlogo), Action Notes (Notas de accidn), Slugging y Notes (Notas). Los tipos Dialogue (Didlogo) y Action
Notes (Notas de accidon) se pueden obtener directamente del guion, y Notes (Notas) se puede utilizar para
almacenar informacion como encabezados de escena, transiciones y otra informacidn util. Los cuadros de texto
de Slugging se suelen agregar mas tarde, mientras se crea el storyboard, para proporcionar indicaciones de
tiempo sobre los dialogos y acciones para la animatica.

Escritura de un guion

Puede escribir el guion del storyboard directamente en la vista de storyboard.

Escritura del guion en el proyecto de Storyboard Pro

1. Abra la vista de storyboard. De forma predeterminada, estard en el panel derecho de la zona de
trabajo.

Panel = Storyboarc ool Propel o Library 1%

— Project Information:

2. Haga clic en el interior del campo de texto.

3. Comience a escribir el guion.
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Storyboard Pro comprueba la ortografia de las palabras que escribe en la vista de storyboard, asi como en los
campos de cuadro de texto de la vista de panel, con el diccionario de un idioma especifico. Puede cambiar el
idioma del corrector ortografico al idioma en el que esta escribiendo.

NOTA

De forma predeterminada, la correccion ortografica se realiza en inglés (EE. UU.) si Storyboard Pro
se inicia por primera vez en inglés, y en espariol (ES) si Storyboard Pro se inicia por primera vez en
espanol.

Si se inicia Storyboard Pro por primera vez en chino o japonés, no se seleccionard ningun
diccionario de forma predeterminada y tendra que seleccionar un diccionario para habilitar el
corrector ortografico. Storyboard Pro no tiene diccionarios en chino y japonés.

Cambio del diccionario utilizado para el control de ortografia automatico
1. En el mend superior, seleccione Captions > Spelling > Spell Check (Cuadros de texto > Ortografia

> Corrector ortografico).

Aparece el cuadro de didlogo Spelling (Ortografia).

Correcciones
ortograficas

2. Enla lista desplegable Language (Idioma) situada en la parte inferior, seleccione el idioma en el
que desea escribir el guion:

English (AU): Inglés (Australia)

English (US): Inglés (Estados Unidos)

English (CA): Inglés (Canad3d)

English (GB): Inglés (Reino Unido)
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» Espanol (ES): Espaniol (Espafia)

» Francais (FR): Francés (Francia)

« $F=10{ (KR): Coreano

» Portugués (BR): Portugués (Brasil)

» Portugués (PT): Portugués (Portugal)

¢ pycckuin (RU): Ruso

* No Spellchecking (Sin correccién ortografica): Deshabilita la correccidon ortografica
La correccion ortografica automatica se hara ahora con el diccionario seleccionado.

3. Hagaclic en Close (Cerrar).

Corrector ortografico

En cualquier momento, mientras escribe el guion o rellena los cuadros de texto del proyecto o después de
hacerlo, puede utilizar el cuadro de didlogo Spelling (Ortografia) para revisar y corregir los errores ortograficos
que detecte el corrector ortografico de Storyboard Pro.

El cuadro de didlogo Spelling (Ortografia) revisara todos los errores de ortografia que pueda encontrar en el
proyecto, incluso en el guion y los cuadros de texto del panel. Comenzard a buscar errores ortograficos por el
campo de texto seleccionado en la posicién en la que se encuentra el cursor de escritura.

Correccion de errores ortograficos en el guion o los cuadros de texto del proyecto

1. Coloque el cursor de escritura donde desee comenzar a comprobar los errores de ortografia:

» Sidesea revisar la ortografia de todo guion, abra la vista de storyboard y haga clic en el
campo Script (Guion), cerca de la esquina superior izquierda, para colocar el cursor de
escritura al principio del guion.

31



Capitulo 5: Adicidn de un guion y de cuadros de texto

» Sidesea revisar la ortografia de todos los cuadros de texto del proyecto, seleccione el primer
panel del proyecto en la vista de imagenes en miniatura o de linea de tiempo, abra la vista
de panely, a continuacién, haga clic dentro del primer campo de cuadro de texto, cerca de la
esquina superior izquierda, para colocar el cursor de escritura al principio de este cuadro de

texto.

» Sidesea revisar la ortografia de un cuadro de texto especifico del proyecto, seleccione el
panel que contenga ese cuadro de texto en la vista de imagenes en miniatura o de linea de
tiempo, abra la vista de panel y, a continuacién, haga clic dentro del campo de cuadro de
texto que desea comprobar, cerca de la esquina superior izquierda, para colocar el cursor de
escritura al principio de este cuadro de texto.

» Sisolo desea ver las sugerencias de ortografia para una palabra mal escrita especifica,

Unicamente tiene que resaltar esa palabra.
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2. En el menu superior, seleccione Captions > Spelling > Spell Check (Cuadros de texto > Ortografia
> Corrector ortografico).

Aparece el cuadro de didlogo Spelling (Ortografia). La primera palabra que encuentre en el guion o
en el cuadro de texto que no exista en su diccionario se seleccionara en la vista de storyboard o de
panel. También aparecera en el cuadro de didlogo Spelling (Ortografia), junto a la etiqueta
Unknown Word: (Palabra desconocida:).

Las sugerencias sobre como corregir la palabra, si existe alguna, se enumeraran en la lista
siguiente. Se seleccionara la primera sugerencia de la lista y también aparecera en el campo
Replace With: (Sustituir por:).

Correcciones
ortograficas
sugeridas

3. Para cada error de ortografia recogido en el cuadro de didlogo Spelling (Ortografia), realice una de
las siguientes acciones:

e Para corregir esta palabra en concreto, seleccione la palabra correcta en la lista de
sugerencias de ortografia o escriba la palabra correcta en el campo Replace With: (Sustituir
por:) y haga clic en Replace Once (Sustituir una vez).

e Para reemplazar todas las palabras escritas de esta manera en el proyecto por la palabra
correcta, seleccione la palabra correcta en la lista de sugerencias de palabras o escriba la
palabra correcta en el campo Replace With: (Sustituir por:) y, a continuacidn, haga clic en
Replace All (Sustituir todos).

NOTA
Se reemplazara la palabra seleccionada del guion y todos los cuadros de texto

del proyecto.

» Para omitir la correccidn de esta palabra y pasar al siguiente error ortografico, haga clic en
Skip (Omitir).
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» Paraignorar los casos de esta palabra escrita de esta manera especifica, haga clic en Ignore
AU (Ignorar todo).

NOTA

Storyboard Pro ignorara todas las coincidencias de este error ortografico durante
el resto de la sesidn. La proxima vez que inicie Storyboard Pro, volvera a detectar
este error ortografico.

» Sila palabra estd bien escrita y no desea que se muestre en el cuadro de didlogo Spelling
(Ortografia) en el futuro, haga clic en Add to Dictionary (Agregar al diccionario). La palabra
se agregara al diccionario personal para evitar que Storyboard Pro la considere un error
ortografico en el futuro.

Cada vez que realice una accion sobre un error ortografico, el cuadro de didlogo Spelling
(Ortografia) pasara inmediatamente al siguiente error ortografico que encuentre a medida que pase
por el guion y los cuadros de texto del proyecto.

Una vez que se hayan corregido todos los errores ortograficos, en el campo Unknown Word:
(Palabra desconocida:) aparecera No errors found (No se han encontrado errores).

4. Una vez que haya terminado de revisar la ortografia del proyecto, haga clic en Close (Cerrar).

Importacion de un guion

Puede importar un guion en texto sin formato (. txt), formato de texto enriquecido (. rt£) o en un archivo
XML de Final Draft (. £dx) directamente en el campo Script (Guion) de la vista de storyboard. También puede
copiarlo y pegarlo desde el editor, o escribirlo directamente en la vista de storyboard.

Importacion de un guion en un proyecto de Storyboard Pro

1. En la vista de storyboard, haga clic en el botén Menu (Menu) [E] situado sobre el lado derecho del
campo de texto y:

» Siel guion estd en texto sin formato (. txt) o en formato de texto enriquecido (. rtf),
seleccione Import Caption (Importar cuadro de texto).

» Siel guion esta en formato XML de Final Draft (. £dx), seleccione Import Final Draft Script
(Importar guion de Final Draft).

2. Enel buscador de archivos, localice y seleccione el archivo de guion y haga clic en Open (Abrir).

El guion aparece en el campo de cuadro de texto Script (Guion).
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Panel | Storyboard | Tool Proper - Library | 1%
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Adicion de cuadros de texto

Una vez importado el guion, puede crear la estructura basica del storyboard creando escenas y paneles vacios
en funcién de los encabezados de escena, acciones y didlogos del guion, y, a continuacidn, rellenando los
campos de cuadro de texto de cada panel del storyboard con informacién del guion.

Para ello, puede seleccionar un fragmento del guion en la vista de storyboard y, a continuacidn, puede
arrastrarlo y colocarlo en un campo de cuadro de texto en la vista de panel, copiando al instante el texto
seleccionado en el campo de cuadro de texto del panel actual.

NOTA

Para aprender a crear escenas y paneles, consulte Adicidn de escenas y paneles en la pagina 22.

Cdémo arrastrar y colocar texto desde el guion en campos de cuadro de texto

1. Cambie a la zona de trabajo vertical mediante una de las siguientes acciones:

» En la barra de herramientas de zona de trabajo, haga clic en el botdn Vertical Workspace
(Zona de trabajo vertical) B=.

* En el mend superior, seleccione Windows > Workspace > Workspace > Vertical (Ventanas
> Zona de trabajo > Zona de trabajo > Vertical).
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2. En el panel derecho de la zona de trabajo, seleccione la pestafa Storyboard.

La zona de trabajo tiene ahora una lista vertical de cada panel del storyboard a la izquierda, con sus

campos de cuadro de texto correspondientes en el centro y el guion del storyboard a la derecha.

3. Enla vista de imagenes en miniatura, desplacese al panel en el que desee agregar cuadros de
texto.

4. En el campo de cuadro de texto Script (Guion) de la vista de storyboard, seleccione la parte del
guion que desea agregar a un cuadro de texto del panel.

5. En el cuadro de texto Script (Guion), arrastre el texto seleccionado y coldquelo en el campo de
cuadro de texto adecuado del panel.

6. Repitalo hasta que haya copiado todo el texto necesario para cada uno de los paneles en sus
campos de cuadro de texto.

36



Guia de introduccién de Storyboard Pro 24

CONSEJO

También puede arrastrar y colocar texto desde cualquier cuadro de texto del panel a
otro cuadro de texto del panel, o desde un cuadro de texto del panel al guion.

7. Una vez que haya terminado, puede restaurar la zona de trabajo que estaba utilizando
seleccionandola desde la barra de herramientas de zona de trabajo o desde el menu superior. Por
ejemplo, la zona de trabajo predeterminada es Drawing Workspace (Zona de trabajo de dibujo).
Para restaurar esta zona de trabajo, realice una de las siguientes acciones:

* En la barra de herramientas de zona de trabajo, haga clic en el botén Drawing Workspace
(Zona de trabajo de dibujo) &zs.

* En el mend superior, seleccione Windows > Workspace > Drawing (Ventanas > Zona de
trabajo > Dibujo).

Creacion de un proyecto a partir de un guion de Final Draft

Si el guion se ha escrito en Final Draft, puede generar automaticamente un proyecto con escenas, paneles
vacios y cuadros de texto previamente rellenos basados en la estructura del guion. Por ejemplo, puede
generar un proyecto con una nueva escena para cada encabezado de escena y un nuevo panel para cada
accion o didlogo, y almacenar el contenido de estos parrafos en los campos de cuadro de texto de sus paneles,
lo que le permite iniciar el proceso de creacidn de storyboard.

Creacion de un proyecto a partir de un guion de Final Draft

1. En el mend superior, seleccione File > New From Final Draft Script (Archivo > Nuevo desde guion
de Final Draft).

Se abre el cuadro de dialogo Import from Final Draft (Importar de Final Draft).
2. Haga clic en el botén Browse (Examinar) 7.

3. En el explorador de archivos, localice y seleccione el guion de Final Draft y haga clic en Open
(Abrir).

Una vez cargado el guion, los tipos de etiquetas que figuran en el guion apareceran en la lista de la
izquierda. Tendra que indicar a Storyboard Pro qué hacer con cada una de estas etiquetas al
generar el proyecto.
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Add caption field

Import

4. En lalista de la izquierda, seleccione Scene Heading (Encabezado de escena):
a. Enelment desplegable Accidn (Accidn), seleccione New Scene (Nueva escena).

b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino),
seleccione Notes (Notas).

c. Silos elementos de Scene Heading (Encabezado de escena) estan numerados en el guion y
desea incluir su nimero en los cuadros de texto del proyecto, marque la opcion Include
Element Number when available (Incluir nimero de elemento cuando esté disponible).

El storyboard dispondra de una escena para cada encabezado de escena del guion, y la descripcién
de la escena se agregara al cuadro de texto Notes (Notas) del primer panel de cada escena.

Add caption field

Import

5. Enla lista de la izquierda, seleccione la etiqueta Action (Accién) y, a continuacion:

a. Sidesea que se cree un panel para cada accidn, seleccione New Panel (Nuevo panel) en la
lista desplegable Action (Accidn).
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b. Sidesea combinar acciones consecutivas en el mismo panel, active la opcion Combine
successive elements (Combinar elementos sucesivos).

c. Enla lista desplegable Destination caption field (Campo de cuadro de texto de destino),
seleccione Action Notes (Notas de accidn). Esta accidon almacenara el contenido de la
etiqueta de accidn en el cuadro de texto Action Notes (Notas de accidon) de cada panel.

d. Silos elementos de Action (Accidn) estdn numerados en el guion y desea incluir su nimero
en los cuadros de texto del proyecto, marque la opciéon Include Element Number when
available (Incluir nimero de elemento cuando esté disponible).

6. En la lista de la izquierda, seleccione la etiqueta Character (Personaje), si la hubieray, a
continuacion:

a. Sidesea que se cree un panel para cada didlogo, seleccione New Panel (Nuevo panel) en la
lista desplegable Action (Accidn).

b. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino),
seleccione Dialogue (Dialogo).

c. Silos elementos de Character (Personaje) estan numerados en el guion y desea incluir su
ndmero en los cuadros de texto del proyecto, marque la opcidn Include Element Number
when available (Incluir nimero de elemento cuando esté disponible).

7. Enlalista de la izquierda, seleccione la etiqueta Parenthetical (Paréntesis), si la hubieray, a
continuacion:

a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino),
seleccione Dialogue (Dialogo).
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b. Silos elementos de Parenthetical (Paréntesis) estan numerados en el guion y desea incluir
su nimero en los cuadros de texto del proyecto, marque la opcién Include Element Number
when available (Incluir nimero de elemento cuando esté disponible).

8. Enlalista de la izquierda, seleccione la etiqueta Dialogue (Didlogo), si la hubiera:

a. En la lista desplegable Destination caption field (Campo de cuadro de texto de destino),
seleccione Dialogue (Dialogo).

b. Silos elementos de Dialogue (Didlogo) estan numerados en el guion y desea incluir su
ndmero en los cuadros de texto del proyecto, marque la opcidn Include Element Number
when available (Incluir nimero de elemento cuando esté disponible).

9. Enlalista de la izquierda, seleccione la etiqueta Transition (Transicidn), si la hubiera:
a. Enla lista desplegable Action (Accidn), seleccione New Transition (Nueva transicion).
En general, se sugieren los siguientes ajustes:

Destination caption field (Campo
de cuadro de texto de destino)

Action (Accién)

Action (Accién) New Panel (Nuevo panel) Action Notes (Notas de accidn)
Character (Personaje) New Panel (Nuevo panel) Dialogue (Didlogo)
Dialogue (Dialogo) None (Ninguno) Dialogue (Dialogo)
Parenthetical (Paréntesis) None (Ninguno) Dialogue (Dialogo)

Scene Heading (Encabezado

New Scene (Nueva escena) Notes (Notas)
de escena)

. ., New Transition (Nueva .
Transition (Transicion) . None (Ninguno)
transicion)
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10.

11.

12.

13.

NOTA

Dependiendo de la forma en la que esté estructurado el guion y del ritmo de la accién o
el didlogo, es posible que tenga que intentar crear un proyecto con el guion utilizando
distintas opciones para obtener la mejor estructura de storyboard segun sus
necesidades. Al final, es probable que tenga que dividir o combinar algunos de los
paneles generados automdaticamente.

Si desea que los parametros seleccionados actualmente sean los predeterminados, active la casilla
de verificacién Save as default rules (Guardar como reglas predeterminadas).

Haga clic en Import (Importar).
Aparece el cuadro de didlogo New Project (Nuevo proyecto).

En el cuadro de didlogo New Project (Nuevo proyecto), introduzca el nombre, la ubicacidn, el titulo
y la resolucién del proyecto.

Si el proyecto abierto no se ha guardado, confirme si desea guardarlo.

Se crea el nuevo proyecto con escenas y paneles creados automaticamente, y con los cuadros de
texto rellenos con fragmentos del guion en funcidn de la configuracidon que haya seleccionado.
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Capitulo 6: Adicion y gestion de capas

Cada panel del storyboard puede estar compuesto por una o varias capas de dibujo. Esas capas se agrupan
para realizar el dibujo en cada panel.

Tipos de capas

Storyboard Pro admite cuatro tipos de capas: capas de dibujo de vectores, capas de dibujo de mapa de bits,
capas 3D y grupos.

» Vector Layers (Capas de vectores): Los dibujos de vectores estan formados por puntos y curvas que
componen los contornos de las formas de la ilustracién, junto con el color o las texturas de relleno. Por
lo tanto, la ilustracidn en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos
que contenga una textura.

Al dibujar en una capa de vector, cada trazo de dibujo y cada linea de lapiz es un objeto independiente
que se puede manipular por separado. Puede seleccionar trazos y, a continuacién, moverlos y
transformarlos, incluso si se aplicaron trazos de dibujo sobre ellos. Ademas, debido a que los trazos de
dibujo estan formados por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y
los cambios en la ilustracion.

* Bitmap Layers (Capas de mapa de bits): Los dibujos de mapa de bits se componen de una cuadricula de
pixeles, que son puntos pequefios que tienen un solo color sélido. Las herramientas de dibujo de mapa
de bits permiten colocar trazos de pincel en un Unico lienzo plano y ajustar la ilustracién pixel a pixel si
es necesario.
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Al dibujar en una capa de mapa de bits, cada trazo se compone en el lienzo, por lo que continta siendo
un dibujo Unico que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad
de pixeles sin perder calidad de imagen. De forma predeterminada, la ilustraciéon de mapa de bits tiene
una densidad de pixeles del 100 %, que solo es suficiente para mostrar la ilustracién sin ampliarla o
escalarla; de lo contrario, Storyboard Pro debe generar nuevos pixeles en la ilustracidn, lo que puede
hacer que se vea borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de pixeles requerida para la ilustracién de
mapa de bits, en funcidn de si tendra que ampliarla o escalarla, antes de comenzar a dibujar en una
capa de mapa de bits.

» 3D Layers (Capas 3D): Cuando importe un modelo 3D en la libreria, si lo agrega a un panel, se
almacenara el modelo en una capa 3D. A continuacion, puede manipular y animar el modelo 3D al igual
gue con una capa de dibujo.

e Group (Grupo): Un grupo puede contener varias capas de cualquier tipo. Al igual que puede transformar
y animar una capa, también puede transformar y animar un grupo. Las transformaciones y animaciones
aplicadas a un grupo afectaran a todas las capas del grupo simultaneamente.

La forma mas fécil de seleccionar y gestionar capas en un panel es utilizar el panel Layer (Capa), que se
encuentra de forma predeterminada en la seccidn derecha de las vistas de escena y de camara.

Panelde
capas

O EE e 0O o [~

Sin embargo, también se puede agregar la vista de capas a la zona de trabajo, que funciona de la misma
manera. A continuacion, puede ocultar el panel Layer (Capa) haciendo clic en el botén Collapse (Contraer) }}
situado en su esquina superior izquierda, y contar con mas espacio para trabajar en las vistas de escena y de
camara.
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También puede gestionar capas utilizando la vista de imagenes en miniatura. Si el tamafio de la vista de
imagenes en miniatura es lo suficientemente grande, cada panel tendra una lista vertical de capas en su borde
derecho que le permitird desplazarse por ellas y seleccionarlas. A la izquierda de la vista de imagenes en
miniatura, debajo de la barra de herramientas de herramientas, se encuentra una barra de herramientas de
capas, que le permite agregar capas al panel seleccionado o eliminarlas del mismo.

# 1(1/1) 01:00

Desplazar
hacia arriba

I Mueva capa de vector

I Mueva capa de mapa de bits

I Bloquear/desbloguear capa

I Mesa de luz automatica

Desplazar
hacia abajo

Adicion de capas

De forma predeterminada, un panel contiene un fondo (BG) y una capa de dibujo (A), pero puede agregar
tantas capas como necesite a cada panel del proyecto.

Adicion de una capa a un panel

1. En lavista de imdgenes en miniatura o de linea de tiempo, seleccione el panel al que desea agregar
una nueva capa.

2. Enel panel Layer (Capa) de la vista de escena o de camara, de la vista de capas o de la vista de
imdgenes en miniatura, seleccione la capa sobre la que desea crear una nueva capa.

3. Realice una de las siguientes acciones:
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* Haga clic en el botdn Add Vector Layer (Agregar capa de vector) #4 o Add Bitmap
Layer (Agregar capa de mapa de bits) @ . Estos botones se encuentran en la parte
inferior del panel Layer (Capa) en las vistas de escena y de camara, en la parte inferior
de la vista de capas y en la barra de herramientas de capas.

» En el mend superior, seleccione Layer > New > Vector Layer (Capa > Nueva > Capa
de vector) o New Bitmap Layer (Nueva capa de mapa de bits).

Eliminacion de capas

Puede eliminar capas que no necesite para evitar abarrotar la lista de capas.

Eliminacidn de una capa de un panel

1. Enel panel Layer (Capa) de la vista de escena o de camara, de la vista de capas o de la vista de
imagenes en miniatura, seleccione la capa que desea eliminar.

2. Realice una de las siguientes acciones:

* Haga clic en el botdn Delete Selected Layers (Eliminar capas seleccionadas) ﬁ:ﬂ Este
botdn se encuentra en la parte inferior del panel Layer (Capa) en las vistas de escena
y de camara, en la parte inferior de la vista de capas y en la barra de herramientas de
capas.

» Haga clic con el botén derecho en la capa y seleccione Delete Layers (Eliminar
capas).

* En el mend superior, seleccione Layer > Delete Layers (Capa > Eliminar capas).

Agrupacion de capas

Puede agrupar las capas para facilitar su gestidn o si desea transformar y animar varias capas a la vez.

Agrupacion de capas

1. En el panel de capas de la vista de escena o de cdmara o en la vista de capas, seleccione al menos
dos capas que desee agrupar.

2. Realice una de las siguientes acciones:

» Haga clic en el botdn Group Selected Layers (Agrupar capas seleccionadas) | #. Este botdn
se puede encontrar en la parte inferior del panel de capas en la vista de escena o de camara,
y en la parte inferior de la vista de capas.
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» Haga clic con el botdén derecho en la seleccidn y, a continuacion, seleccione Group Selected
Layers (Agrupar capas seleccionadas).

* En el mend superior, seleccione Layer > Group Selected Layers (Capa > Agrupar capas
seleccionadas).

(- CONSEJO

4 \

Puede arrastrar y colocar capas dentro o fuera de grupos.

Ocultar y visualizar capas

Al trabajar con muchas capas, puede ocultar temporalmente determinadas capas para evitar abarrotar la
escena.

Capa visible

También puede ocultar un grupo. Al ocultar un grupo, todas las capas que contiene aparecen ocultas, pero se
conserva su estado de visibilidad individual. Por lo tanto, si oculta solo algunas capas de un grupo, oculte el
grupo vy, a continuacién, muéstrelo. Asi, las capas que se ocultaron individualmente permaneceran ocultas, y
las que estaban visibles se volveran a ver.

La capa de grupo es visible. Dos de El grupo v todas sus capas estan
sus subcapas son visibles y dos estén ocultos. Se conserva el estado de
visibilidad (mostrado u oculto) de
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Como mostrar u ocultar una capa

1. Realice una de las siguientes acciones:

* En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Show/Hide Layer
(Mostrar/ocultar capa) (s justo a la izquierda de la capa.

» En la vista de imagenes en miniatura, haga clic en el icono Show/Hide Layer (Mostrar/ocultar
capa) ({9 justo debajo del nombre de la capa.

* En el panel Layer (Capa), la vista de capas o la vista de imagenes en miniatura, haga clic con
el botén derecho en la capa y seleccione Show/Hide Layers (Mostrar/ocultar capas).

* En el panel Layer (Capa), la vista de capas o la vista de imagenes en miniatura, seleccione la
capay, a continuacidn, seleccione Layer > Show/Hide Layers (Capa > Mostrar/ocultar capas)
en el menu superior.

Bloqueo y desbloqueo de capas

Puede bloquear una capa seleccionada con el fin de proteger los objetos que contenga para impedir que se
cambien. Una vez bloqueada, puede desbloquearla para realizar cambios en cualquier objeto de la misma.

Capa
desbloqueada

Capa
bloqueada

Bloqueo o desbloqueo de una capa

1. Realice una de las siguientes acciones:

e En el panel Layer (Capa) o en la vista de capas, haga clic en el icono Lock/Unlock
(Bloquear/desbloquear) f@ justo a la izquierda de la capa.

* En la vista de imdgenes en miniatura, haga clic en el icono Lock/Unlock
(Bloquear/desbloquear) fg@ justo debajo del nombre de la capa.

e En el panel Layer (Capa), en la vista de capas o la vista de imagenes en miniatura, seleccione
la capa. A continuacion, realice una de las siguientes acciones:

e A continuacidn, seleccione Layer > Lock/Unlock Layers (Capa >
Bloguear/desbloquear capas) en el menu superior.

47



Capitulo 6: Adicidn y gestién de capas

» En la barra de herramientas de capas, haga clic en el botdn Lock/Unlock Layers
(Bloquear/desbloquear capas) [ .

e Pulse Alt + L.
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Capitulo 7: Como dibujar y pintar

Cémo dibujar
Al crear un nuevo proyecto en Storyboard Pro, puede comenzar a dibujar inmediatamente en el panel

seleccionado utilizando una de las herramientas de dibujo a su disposicion.

Dibujo con la herramienta Brush (Pincel)

1. En lavista de linea de tiempo o de imdgenes en miniatura, seleccione el panel en el que desea
dibujar.

2. Enel panel Layer (Capa) de la vista de escena, seleccione la capa sobre la que desea dibujar.

3. Realice una de las siguientes acciones:
e En la barra de herramientas de herramientas, seleccione la herramienta Brush (Pincel) »”.
e En el mend superior, seleccione Tools > Brush (Herramientas > Pincel).

¢ Pulse Alt + B.

4. En lalista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione
un pincel predefinido que desee utilizar.

5. Utilice el control deslizante Maximum Size (Tamafio maximo) para seleccionar el tamafio deseado
para el pincel.

6. En la vista de color, realice una de las siguientes acciones para seleccionar un color:

* Haga doble clic en la muestra de color actual para abrir la ventana Colour Picker (Selector de
color).

 Utilice los controles deslizantes Hue (Matiz), Saturation (Saturacién) y Value (Valor) para
seleccionar el color con el que desea dibujar.
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¢ Seleccione una muestra de color de la lista de muestras.

| Control deslizante de matiz

| Control deslizante de saturacion

| Control deslizante de valor

Muestras
de colores

7. Enlavista de escena, dibuje un trazo de pincel.

8. Sidesea realizar cambios en su pincel, en la vista de propiedades de la herramienta, haga clic en el
botdn de flecha para abrir el cuadro de didlogo Brush Properties (Propiedades del pincel). En este
cuadro de didlogo, puede personalizar la forma, la textura y el comportamiento del pincel.

. /\/ I

_‘Q'. CONSEJOS

» Puede ajustar rapidamente el tamafo de la herramienta de dibujo seleccionada
manteniendo pulsada la tecla y, a continuacién, haciendo clicen lateclaOy, a
continuacidn, arrastrando en el espacio de dibujo. Si utiliza un lapiz de tableta, al hacerlo
con la punta del borrador del lapiz ajustara el tamarfio de la herramienta Eraser (Borrador),
independientemente de la herramienta de dibujo seleccionada.

* Simantiene pulsada la tecla MayUs antes de dibujar o mientras lo hace, dibujara una linea
recta.

« Simantiene pulsadas las teclas Mayus y Alt antes de dibujar o mientras lo hace, dibujara
una linea recta horizontal o vertical.

¢ Simantiene pulsada la tecla Ctrl (Windows/Linux) o 8 (macOS) mientras dibuja, su trazo
de dibujo se convertira en una forma cerrada.

¢ Simantiene pulsada la tecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un
dibujo existente, el comienzo del trazo se conectara con el otro dibujo.

¢ Simantiene pulsada la tecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro
dibujo existente, el final del trazo se conectara con dicho dibujo.
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Cdémo pintar

También puede pintar los dibujos para obtener un aspecto mas acabado. Puede pintar los personajes y props
con sus esquemas de color, o simplemente rellenarlos de blanco para que sus contornos no se mezclen con el
fondo.

Cémo pintar un dibujo

1. Realice una de las siguientes acciones:
» En la barra de herramientas de herramientas, seleccione la herramienta Paint (Pintar) ® .
* En el mend superior, seleccione Tools > Paint (Herramientas > Pintar).
* Pulse Alt + 1.

2. Enla vista de color, realice una de las siguientes acciones para seleccionar un color:

e Haga doble clic en la muestra de color actual para abrir la ventana Colour Picker (Selector de

color).

 Utilice los controles deslizantes Hue (Matiz), Saturation (Saturacion) y Value (Valor) para

seleccionar el color con el que desea dibujar.

¢ Seleccione una muestra de color de la lista de muestras.

| Control deslizante de matiz

| Control deslizante de saturacion

| Control deslizante de valor

Muestras
de colores

3. Enla vista de escena, empiece a pintar en el dibujo haciendo clic en el drea que desea pintar. Si
desea rellenar varias dreas al mismo tiempo, dibuje un lazo alrededor de ellas.
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NOTA

Si la forma que esta tratando de pintar no estd completamente cerrada, no se rellenara.
Puede hacer que la herramienta Paint (Pintar) cierre automaticamente pequefios
huecos en las formas que intenta rellenar aumentando la configuracion de Close Gap
(Cerrar hueco) () de la herramienta Paint (Pintar) en la vista de propiedades de la
herramienta. Para cerrar huecos grandes, puede utilizar la herramienta Close Gap
(Cerrar hueco) (7, disponible en el mend emergente de la herramienta Paint (Pintar)

® en la barra de herramientas de herramientas.

Acerca de estilos artisticos, herramientas de dibujo y tipos de capas

Las dos herramientas de dibujo principales en Storyboard Pro son la herramienta »~ Brush (Pincel) y la
herramienta # Pencil (Lapiz). Seguin el estilo de dibujo que desee lograr, es posible que prefiera trabajar con
capas de vectores o de mapas de bits.

En las capas de vectores, es posible dibujar con lineas de lapiz, lineas de lapiz con textura, pinceles de vectores
y pinceles de vectores con textura. Mientras que las lineas de lapiz son lineas centrales de vectores a las que
puede agregar grosor, los trazos de pincel son formas de vector sélidas rellenas con un color y los trazos de
pincel con textura son trazos de pincel rellenos de una textura de mapa de bits que filtra su color.
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Linea de lapiz

ITrazo de pincel de vectores]

%

I Linea de lapiz con textura I

I Trazo de pincel con textura I

En las capas de mapa de bits, solo puede dibujar utilizando pinceles de mapa de bits sélidos o con textura. Por
lo tanto, aunque las capas de vectores son mas flexibles porque permiten manipular y ajustar facilmente
partes de la ilustracidn, también pueden albergar mas estilos artisticos.

Sin embargo, si utiliza un pincel con textura en una capa de vectores, los trazos de pincel tendran una textura
de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa de bits, intentar ajustar o
cambiar el tamafio de un trazo de pincel con textura requerird que Storyboard Pro vuelva a probar la textura,
lo que puede hacer que pierda calidad de imagen, a menos gue su resolucidn de textura se hubiera aumentado
Lo suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los
dibujos de mapa de bits siempre estan hechos de un solo lienzo plano, los trazos de pincel de vectores se
guardan como objetos independientes. Esto significa que colocar muchos trazos de pincel con textura en un
dibujo de vectores requerira que Storyboard Pro almacene la textura para cada uno de estos trazos y los
componga en tiempo real para mostrar el dibujo. Esto puede hacer que los dibujos de vectores cargados de
textura, a diferencia de los dibujos de mapa de bits, hagan que el rendimiento de la aplicacién sea mas lento y
el tamano del archivo sea mayor. Sin embargo, este es el Unico caso en el que es probable que un dibujo de
vectores sea mas pesado que un dibujo de mapa de bits.

Aunque no se recomienda para el esbozo, las lineas de ldpiz con textura son una buena solucién. Las lineas de
Llapiz con textura son mas ligeras y faciles de editar. Esto significa que la textura se actualizara con la
transformacion si escala o ajusta la linea de lapiz. Esto también significa que se puede cambiar la textura
aplicada a una linea de lapiz existente o aplicar una textura a una linea de lapiz que aun no la tenga. Las
texturas de pincel se recomiendan sobre las lineas de ldpiz con textura cuando se trata de conseguir
pinceladas de aspecto natural.
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NOTA

Incluso si aplana la ilustracion, los trazos de pincel con textura de distintos colores no se pueden
aplanar juntos en capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Storyboard Pro:

Herramienta de
dibujo

Especificaciones

Ventajas: muy ligero y facil de ajustar. Se puede manipular, volver a
colorear y ajustar mediante la linea central. Se puede acercar o aumentar
de tamano sin perder calidad.

Ldépiz solido Vector . , o )
Desventajas: no esta optimizado para transparencia.

Uso recomendado: dibujos limpios con un estilo de contorno sélido y
uniforme.

Ventajas: ligero y facil de ajustar. Se puede manipular, volver a colorear y
ajustar mediante la linea central. Se puede acercar o aumentar de tamafio
sin perder calidad.

L. Desventajas: no estd optimizado para transparencia. No se recomienda
Lapiz con textura Vector . . .
para realizar bocetos. No tiene un aspecto tan natural como los pinceles
con textura.

Uso recomendado: para ilustraciones de textura ligera o de estilo mixto
que requieren mucha manipulacién de lineas.

Ventajas: tamafio de archivo ligero. Reproduce el estilo de animacién

tradicional. Se puede manipular, volver a colorear y editar mediante el
. contorno o la linea central. Se puede acercar o aumentar de tamafio sin
Pincel de vectores Rk
L. Vector perder calidad.
sélido
Desventajas: no puede reproducir el aspecto de los medios naturales.

Uso recomendado: bocetos, dibujos limpios de animacién tradicional.

Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta
con las mismas capacidades que los pinceles de mapa de bits con textura,
pero se puede manipular, editar y volver a colorear como un pincel de

vectores sélido.
Pincel de vectores
Vector

con textura Desventajas: los trazos superpuestos de pincel pueden provocar que el

dibujo haga que el rendimiento de la aplicacion sea lento y el tamafio de los
archivos sea pesado. Los trazos de pincel de distintos colores no se pueden
aplanar a la vez. Si se ajusta, aumenta de tamafio o acerca la ilustracién,
puede disminuir la calidad de la textura.
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Herramienta de Tipo de
dibujo capa

Especificaciones

Uso recomendado: para ilustraciones con textura de estilo de mapa de bits
ligera o ilustraciones de estilo mixto.

Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor
rendimiento y tamafio de archivo mas ligero que las ilustraciones de
vectores cargados de textura. Se puede editar pixel a pixel.

Pincel de mapa de Mapa de Desventajas: los trazos de pincel siempre se aplanan a la vez y no se

bits con textura bits pueden modificar por separado. Solo se pueden dibujar o borrar. Si se
aumenta de tamafio o se acerca la ilustracién, puede disminuir la calidad de
la imagen.

Uso recomendado: ilustracion de mapa de bits cargado de textura.
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Capitulo 8: Uso de guias de dibujo

Las guias de dibujo son ayudas para dibujar que puede agregar a su panel para ayudarle a dibujar fondos y
objetos con lineas rectas, angulos rectos y efectos de proyeccidn grafica, como la proyeccion isométrica, la
perspectiva recta y la perspectiva curvilinea. En el arte tradicional, esto se hace con herramientas, como reglas,
reglas T, escuadras y puntos de desaparicidn. Las guias permiten simular el uso de dichas herramientas junto
con las herramientas de dibujo en Storyboard Pro.

Storyboard Pro admite distintos tipos de guias de dibujo, cada una disefiada para distintos tipos de tareas de
dibujo. La mayoria de las guias de dibujo de Storyboard Pro funcionan agregando una linea de horizonte y
puntos de desaparicion a su espacio de dibujo. Cuando utiliza una guia de dibujo, aparecen lineas de guia de
puntos mediante el cursor del ratdn. Estas lineas de guia son paralelas o perpendiculares a la linea de
horizonte, o van desde uno de los puntos de desaparicién de la guia hasta el cursor del ratén. Cuando empieza
a dibujar un trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guia, como si
dibujara con una regla. También puede utilizar las guias de dibujo como simples referencias visuales sin fijar la
herramienta de dibujo a los ejes.

Storyboard Pro admite los siguientes tipos de guias de dibujo:

» Laregla le permite colocar y rotar un eje y, a continuacion, dibujar una linea a lo largo de dicho eje,
como una regla normal.

* La cuadricula cuadrada le ayuda a dibujar lineas paralelas o perpendiculares a la linea de horizonte.

L

=y
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* |aguia de perspectiva isométrica le ayuda a dibujar lineas paralelas a uno de los tres ejes: el eje x, el
eje vy, y el gje z. EL angulo de cada eje se puede personalizar segin sea necesario.

Este tipo de seudoperspectiva, también conocida como proyeccidn paralela, a menudo se utiliza en
juegos 2D, infografias y esquemas para representar objetos y entornos 3D sin utilizar ninguna
perspectiva, escorzo o renderizado 3D real. En la animacién 2D, a menudo se utiliza para dibujar fondos

de paneo largos desde un dngulo alto o bajo.

» Laguia de perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un Unico punto de
desaparicidn en el centro del horizonte. También le ayuda a dibujar lineas paralelas o perpendiculares a

la linea de horizonte.

Esto es Util para dibujar estructuras de forma de cuboide que se encuentran de cara a la camara.

* La guia de perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
desaparicidn, que se colocan en la linea de horizonte fuera del campo de la camara. También le ayuda a

dibujar lineas perpendiculares a la linea de horizonte.

Esto es Util para dibujar estructuras de forma de cuboide desde un angulo horizontal especifico.
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e Laguia de perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los tres puntos de
desaparicidon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de desaparicion en
la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el eje z. El otro punto
de desaparicién se coloca debajo de la linea de horizonte para ayudarle a dibujar lineas en el gje y.

Esto es Util para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

* |aguia de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar lineas procedentes de uno de los
tres puntos de desapariciéon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de
desaparicidn en la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el
eje z. El otro punto de desaparicién se coloca encima de la linea de horizonte para ayudarle a dibujar
lineasenel ejey.

Esto es util para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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* |Laguia de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panoramicos
horizontales, con lineas horizontales curvilineas. Un punto de desaparicidon se coloca en el centro de la
linea de horizonte para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicién se colocan en
la linea de horizonte fuera del campo de la camara para definir la curva de las lineas horizontales. Las
lineas verticales se colocan perpendicularmente a la linea de horizonte.

Esto es Util para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la
camara sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo horizontal) simulara
una rotacién de la cdmara en el gje v.

]

- : -
__/

e Laguia de perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panoramicos verticales,

con lineas verticales curvilineas. Un punto de desaparicidn se coloca en el centro de la linea de
horizonte para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicidn se colocan debajo de la
linea de horizonte, fuera del campo de la cdmara, para definir la curva de las lineas verticales. Las lineas
horizontales se colocan en paralelo a la linea de horizonte.

Esto es util para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la cdmara
sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo vertical) simulara una rotacion
vertical de la camara en el gje X.
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La guia de perspectiva continua con 4 puntos es muy parecida a la guia de perspectiva con 3 puntos
(paneo horizontal), salvo que esta disefiada para ayudarle a dibujar fondos panoramicos completos de
360°.

Esta guia utiliza 5 puntos de desaparicidon. Cuando dibuja una linea horizontal, se curva formando un
arco sobre uno de los puntos de desaparicion y llegando hasta los dos puntos de desaparicion
circundantes. Esto crea un efecto de perspectiva donde cada punto de desaparicion representa uno de
los puntos cardinales, salvo los puntos mas a la izquierda y mas a la derecha que representan el mismo
punto cardinal, lo que crea un fondo en bucle. Los fondos creados con la guia de perspectiva continua
con 4 puntos se pueden repetir en bucle horizontalmente para simular una rotacion completa de la

camaraen el gjey.

Sur | Este I

La guia de perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la guia de
perspectiva con 2 puntos, salvo que sus lineas verticales son curvilineas, para que se pueda utilizar para
crear fondos de paneo verticales. Dos puntos de desaparicion se encuentran en la linea de horizonte,
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fuera del campo de la cdmara, para ayudarle a dibujar lineas en el eje x y el eje z, y dos puntos de
desaparicidn se colocan encima y debajo del campo de la cdmara para definir la curva de las lineas
verticales.

Esto es util para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de
cuboide se ven desde un angulo.

* |aguia de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilineos en el eje x y en
el eje y. Tiene un punto de desaparicién central en la linea de horizonte desde el que se dibujan lineas
en el eje z; dos puntos de desaparicion en los extremos de su linea de horizonte para definir la curva de
lineas horizontales; y dos puntos de desaparicién encima y debajo de la linea de horizonte para definir la
curva de las lineas verticales.

Esta guia se puede utilizar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo
de pez. También se puede utilizar para dibujar fondos que se deben recorrer en varias direcciones.
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Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias del panel actual. Para
familiarizarse con las guias, puede comenzar agregando la guia de dibujo de perspectiva con 1 punto a la lista
de guias.

Adicidn de una guia de dibujo de perspectiva con 1 punto al panel actual

1. En la barra de herramientas de herramientas, seleccione la herramienta & Brush (Pincel), #
Pencil (Lapiz), o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de escena o de cdmara cuando esta
seleccionada una de las herramientas.

2. Agregue la vista de guias a su espacio de trabajo realizando una de las siguientes acciones:

» En la esquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botén ==
Add View (Agregar vista) y seleccione Guides (Guias).

* En el mend superior, seleccione Windows > Guides (Ventanas > Guias).
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3. Enlavista de guias, haga clic en el boton 4+, New Guide (Nueva guia) y seleccioneE/E 1-Point
Perspective (Perspectiva con 1 punto).

La nueva guia aparece en la lista de guias.

Number of Lines
-

Cuando se agrega una guia nueva, su linea de horizonte se configura en una posicién y un angulo predefinidos,
y sus puntos de desaparicidn se configuran en una posicién predefinida. En muchos casos, debe realizar
ajustes en la guia para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guia de perspectiva con 1 punto en una

1. En la barra de herramientas de herramientas, seleccione la herramienta & Brush (Pincel), #
Pencil (Lapiz), 0 / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de escena o de camara cuando estd
seleccionada una de las herramientas.
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2. En lavista de guias, asegurese de que la opcidn Enable Guides (Habilitar guias) esté activada.

3. En la lista de guias, seleccione la guia de {<}-perspectiva con 1 punto en una en la que desee

realizar ajustes.

La guia seleccionada aparece en la vista de escena o de camara.

I Punto de desaparicion

4. Realice una de las siguientes acciones:
» Para cambiar la guia de posicién sin rotarla, haga clic y arrastre su punto de desaparicién @.

» Para rotar la guia, haga clic y arrastre su linea de horizonte.

CONSEJOS

e Cuando el ratdn se coloca encima de la linea de horizonte, el cursor del ratdn
cambiard a ) para indicar que estd a punto de rotar la gufa.

» Al rotar una guia, su angulo se muestra en la esquina superior izquierda de la
vista de escena o de camara.

5. Una vez que haya terminado de realizar ajustes en la guia, puede hacer clic en el botdn [=» Lock
Guides (Bloquear guias) en la vista de guias para evitar modificar su guia accidentalmente mientras
dibuja.

Una vez que la guia esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guias de dibujo

1. En la barra de herramientas de herramientas, seleccione la herramienta & Brush (Pincel), #
Pencil (Lapiz), 0 / Line (Linea).
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NOTA

Las guias de dibujo solo estan visibles en la vista de escena o de cdmara cuando esta
seleccionada una de las herramientas.

2. Enlavista de guias, seleccione la guia que desee usar.

3. Para evitar editar su guia accidentalmente mientras dibuja, haga clic en el botdn =» Lock Guides
(Bloquear guias) en la vista de guias para activarla.

4. Sidesea bloquear sus trazos con los ejes de la guia, asegurese de que la opcién ~ Align
with Guide (Alinear con guia) de la vista de guias esté activa. En caso contrario, desactivela para
poder dibujar libremente y use solo las guias como referencias.

5. Mueva el cursor del ratdn por el espacio de dibujo. Observe que las lineas de guias pasan por el
cursor del ratén, una por cada uno de los ejes de la guia de dibujo.

6. Comience a dibujar en trazo en el mismo angulo que uno de los ejes.

Si la opcién ~" Align with Guide (Alinear con guia) esta habilitada, el trazo se alinea con el eje mas
cercano a su angulo, como si dibujara con una regla.
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CONSEJOS

* También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las
teclas flecha izquierda y de flecha derecha para pasar por cada eje. El eje seleccionado
aparecera mas resaltado que los demas. Si pasa por todos los ejes, ninguin eje estara
resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a
determinar en funcién del dngulo de su trazo.

e Esté dibujando o no, puede fijar la posicién y el angulo de las lineas de guia manteniendo
pulsada la tecla Alt. Las lineas de guia dejaran de seguir el cursor del ratdn, lo que le
permitira mantenerlas en un angulo y posicion especificos. Esto se puede utilizar para
dibujar sobre la misma linea varias veces para ajustar su longitud y grosor.

Una vez que haya terminado de trabajar con las guias, puede deshabilitarlas. Cuando las guias de dibujo estan
deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de
dibujo.

Habilitacion y deshabilitacidn de guias de dibujo

1. Para habilitar o deshabilitar las guias de dibujo, realice una de las siguientes acciones:

» En la vista de guias, haga clic en el botdon Enable Guide (Habilitar guia)

e PulseG.

NOTAS

e Las guias se habilitan automaticamente al agregar una nueva guia o al seleccionar una
s . s
guia en la lista de guias.

» La guia que selecciond en su panel al deshabilitar las guias se volvera a seleccionar cuando
vuelva a habilitar las guias.

» Las guias de dibujo solo funcionan con las herramientas Herramientas &~ Brush (Pincel),
& Pencil (Lapiz) y / Line (Linea). Si se selecciona cualquier otra herramienta, las guias
de dibujo se comportaran como si estuvieran deshabilitadas.
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Capitulo 9: Importacion de imagenes

Sitiene imagenes listas para su storyboard, puede importarlas en el proyecto de Storyboard Pro. Las
imagenes se pueden importar como nuevas escenas en su proyecto o como nuevas capas en un panel. Puede

importar una o varias imagenes al mismo tiempo.

NOTA

También puede importar imagenes como clips de video; consulte Importacion de videos.

Importacion de imagenes como escenas

1. Seleccione File > Import > Images as Scenes (Archivo > Importar > Imdgenes como escenas).
Se abre el buscador Choose Image Files (Seleccionar archivos de imagen).
2. Busque las imagenes que desee, seleccione una o mas imagenes y haga clic en Open (Abrir).

Se crea una nueva escena al final del proyecto para cada una de las imagenes importadas.

Thumbnails == (3%
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Importacion de imagenes como capas en un panel mediante el cuadro de dialogo
Import Images (Importar imagenes)

1. En lavista de imdgenes en miniatura o de linea de tiempo, seleccione el panel en el que desea

importar imagenes.

2. En el menu superior, seleccione File > Import > Images as Layers (Archivo > Importar > Imagenes

como capas).

Se abre el cuadro de didlogo Choose Image Files (Seleccionar archivos de imagen).
3. Busque el directorio que contenga las imagenes que desea importar.

4. Seleccione las imagenes que desea importar.
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4

_‘Q'. CONSEJO
Puede seleccionar varios archivos mediante una de las siguientes acciones:

e Mientras pulsa Ctrl (Windows/Linux) o ¥ (macOS), haga clic en cada uno de los
archivos que desee seleccionar.

» Mientras pulsa Mayus, haga clic en el primer archivo que desee seleccionary, a
continuacidn, en el ultimo archivo que desee seleccionar para seleccionar todos los

archivos intermedios.

5. Haga clic en Open (Abrir).

6. Sise selecciona un archivo Photoshop Document (.psd) con varias capas, aparecera un mensaje
que ofrecera la opcidn de importar cada capa por separado.

» Haga clic en Yes (Si) para importar cada capa del documento como su propia capa en el

panel.

e Haga clic en No para importar todo el documento como una sola capa en el panel.

Se crea en el panel una capa que contiene la imagen importada. Si ha seleccionado mas de una
imagen, cada imagen se importara en su propia capa en orden alfanumérico.

Importacion de imagenes como capas en un panel con arrastrar y colocar

1. Abra la ventana del Explorador (Windows) o el Finder (macQS).

2. Busque la ubicacién de los elementos de imagenes que desee exportar.
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3. Seleccione todos los elementos de imagenes que desee importar.

=l [ = | Pictures Manage - o X

Home Share View Picture Tools e

&« “ A &= » ThisPC » Pictures v D Search Pic... 0

= This PC "
§ 3D Objects

[ Desktop ) I'\" ] 8
= Documents .
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n
J\. Music 2

&= Pictures

m Videos

i Windows 10 (C:) v

Jitems 3 items selected 202 KB ZEEIZI

CONSEJO
Puede seleccionar varios archivos mediante una de las siguientes acciones:

¢ Mientras pulsa Ctrl (Windows/Linux) o % (macOS), haga clic en cada uno de los
archivos que desee seleccionar.

e Mientras pulsa Mayus, haga clic en el primer archivo que desee seleccionary, a
continuacidn, en el Ultimo archivo que desee seleccionar para seleccionar todos los
archivos intermedios.

4. Asegurese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder
estén visibles.

5. En la vista de imagenes en miniatura o de linea de tiempo, realice al menos una de las siguientes
acciones:

» Seleccione el panel en el que desee importar imagenes.
» Desplacese al panel en el que desee importar imagenes.
6. En la ventana del Explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados:

e Paraimportar las imagenes en el panel actual, coloque los archivos seleccionados en la vista
de escena, la vista de cdmara o la vista de capas.

» Paraimportar las imagenes en cualquier otro panel, cologue los archivos seleccionados
sobre el panel de destino en la vista de imagenes en miniatura o de linea de tiempo.
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NOTA

La imagen miniatura del panel de objetivos puede tardar unos segundos en

actualizarse.

panel.
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Capitulo 10: Creacion de una animatica

Una vez creado el storyboard, el siguiente paso es convertirlo en una animatica. Una animética es un video que
reproduce cada panel del storyboard. Cada panel se debe sincronizar para que coincida con el tiempo previsto
de las acciones, y cada escena se debe sincronizar para que coincida con el ritmo previsto de la historia. Los
movimientos de la cdmara se pueden animar para simular cémo se vera la accién en relacién con los
movimientos y el fotograma de cdmara. Las capas del storyboard también se pueden animar para que la
accion y su tiempo se puedan leer con mas facilidad.

Se pueden agregar efectos de sonido, clips de voz y pistas de musica, ya sean provisionales o finales, para
marcar el ritmo de la accidn que las rodea, asi como para crear un borrador de la mezcla de sonido para el
producto final. También se pueden agregar a la animatica videos e imagenes fijas, como secuencias de
apertura o finalizacidn, superposiciones, cuadros de texto, logotipos o material de accidn en vivo para
utilizarlos como referencias o para que no se tengan que crear bocetos en paneles.

En Storyboard Pro, puede crear una animatica a partir del storyboard utilizando la vista de linea de tiempo. La
vista de linea de tiempo se parece mucho a la linea de tiempo de un software de edicién de video. Entre otras
cosas, permite ajustar visualmente el tiempo de cada panel, importar, preparar y recortar los clips de sonido y
de video, animar los movimientos de la camara, animar capas y agregar transiciones entre escenas. Por lo
tanto, le acompanfiara en cada paso hacia la creacién de la animatica.

| Nuevo acto [ Movimiento de camara I [ Cabezal de reproduccic’ml

[Transicic’ml [ Escena I

[ Nueva secuencia I

[ Cddigo de tiempo actual

[ Duracién de proyecto

Pista de video
[ Pista de animacidn de camara Pistas de
[ Fista del storyboard = video vy
Secuencia actual storyboard
[ Pista de animacién de capa Pistasde

Control deslizante de zoom
de linea de tiempo

Clip de sonido

[Restablecer Zoom I [ Animacion de capa]

Sobrescribir clips

[ Modo de edicién de animatica I

’ Ment de linea de tiempo I

Acceso a la vista de linea de tiempo
1. Realice una de las siguientes acciones:

» En la esquina superior derecha de la vista de imagenes en miniatura, haga clic en el botén
== Add View (Agregar vista) y seleccione Timeline (Linea de tiempo).
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» Seleccione Windows > Timeline (Ventanas > Linea de tiempo).

La primera vez que abra la vista de linea de tiempo después de crear un storyboard, observara que todos los
paneles del storyboard ya se encuentran en la pista y sincronizados para que duren un segundo cada uno. Por
lo tanto, el storyboard ya es una animatica sencilla. El siguiente paso desde ese punto es ajustar la longitud de
cada panel para que coincida con el tiempo previsto de las acciones y el ritmo previsto de las escenas.

Antes, durante y después de ajustar el tiempo de los paneles, puede ver como se desarrolla la animatica y

como se percibe con su tiempo actual al previsualizarlo.

Vista previa de la animatica

1. En lavista de linea de tiempo o de imdgenes en miniatura, seleccione el panel que desea reproducir
para comenzar.

2. Enla barra de herramientas de reproduccion, haga clic en el botéon » Play (Reproducir).

Al final, una animatica se puede exportar a archivos de video o incluso a escenas de Toon Boom Harmony;
consulte Exportacion del proyecto en la pagina 119.

Configuracion de la duracion del panel

La duracién de un panel se puede establecer de varias formas. La vista de panel permite escribir la duracién
exacta del panel actual. La vista de linea de tiempo permite ampliar o reducir paneles visualmente. La duracién
de un panel también puede ajustar mediante los atajos de teclado Add Frame to Panel (Agregar fotograma a
panel) y Remove Frame to Panel (Eliminar fotograma de panel).

De forma predeterminada, cuando ajusta la duracién de un panel, este se desplaza o se propaga a todos los
paneles posteriores. De este modo, todos los paneles y escenas se mantienen unidos en una sola secuencia
continua y puede ajustar el tiempo de cada panel por separado.

Definicidn de la duracidon de un panel por fotograma

1. En la vista de linea de tiempo o de imdgenes en miniatura, seleccione un panel.

2. Realice una de las siguientes acciones:
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» En la vista de panel, escriba la longitud exacta del panel en el campo Duration (Duracién).

Panel | Storyboard ool Propel olour | Library %

NOTA

El formato de la duracién es H:MM: SS : FF, donde H significa horas, M significa
minutos, S significa segundos y F significa fotogramas.

» En la vista de panel, a la derecha del campo Duration (Duracién), haga clic en la flecha arriba
A para ampliar el panel un fotograma o en la flecha abajo ¥ para reducir el panel un

fotograma.
e Pulse + para agregar un fotograma al panel o - para eliminar un fotograma del panel.

* En el mend superior, seleccione Storyboard > Add Frame to Panel (Storyboard > Agregar
fotograma a panel) o Storyboard > Remove Frame from Panel (Storyboard > Eliminar

fotograma de panel).

Ajuste de la longitud de un panel en la vista de linea de tiempo y ondulacion de

paneles posteriores

1. Coloque el cursor cerca del borde derecho del panel cuyo tamafio desea cambiar.

Se muestra el icono de cambio de tamano <11| . Aseglrese de que apunta hacia el interior del panel

cuyo tamano desea cambiar.
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2. Hagaclicy arrastre el borde hacia la derecha para ampliarlo o hacia la izquierda para reducirlo.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o
resta al mismo.

[ Nueva longitud deLl [Diferencia de longitud I

Todos los paneles posteriores se ondulardn hacia delante o hacia atrds para conservar su longitud.

(- CONSEJO

4 \

También puede ampliar o reducir un panel haciendo clic y arrastrando su borde izquierdo.

Cuando lo haga, si arrastra hacia la izquierda lo ampliard, y si arrastra hacia la derecha lo
reducira.

[ Mueva longitud del panell [Diferencia de longitud I

También es posible ajustar la longitud de un panel mientras se ajusta simultaneamente la longitud del
siguiente panel para compensarlo. Asi se evita que los paneles posteriores se desplacen y puede ser Util si
necesita ajustar el tiempo de los paneles sin que afecte al tiempo del resto de la animatica.
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Desplazamiento de la transicidn entre dos paneles sin desplazar los paneles
posteriores

1. Mientras mantiene pulsada la tecla Alt, coloque el cursor sobre el borde derecho del panel cuyo
tamano desea cambiar.

Se muestra el icono de cambio de tamafiio <1[|B>.

2. Mientras mantiene pulsada la tecla Alt, haga clic y arrastre el borde del panel hacia la derecha para
ampliarlo o hacia la izquierda para reducirlo.

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o
resta al mismo.

[ Mueva longitud del panell [Diferencia de longitud I

La longitud del siguiente panel se ajustara para evitar el desplazamiento de paneles posteriores.

Modo de edicidon de animatica

De forma predeterminada, los cambios que realice en la longitud de las escenas y los paneles provocaran que
las escenas y los paneles posteriores se propaguen hacia delante y hacia atras para asegurarse de que no
haya ningun hueco en la linea de tiempo.

Cuando Animatic Editing Mode (Modo de edicidén de animatica) esté habilitado, es posible cambiar la posicion
del punto de entrada y de salida de cada panel sin que ello afecte a ningun otro elemento de la animatica. Esto
significa que, en este modo, al acortar o eliminar un panel se crea un hueco en la linea de tiempo en el que se
puede ampliar, mover o crear otro panel. También puede borrar paneles o escenas, y dejar atras los orificios en
lugar de propagar los paneles siguientes hacia atras.

A continuacidn, en los huecos que cred en la animatica, puede mover los paneles existentes, crear nuevos
paneles o cambiar el tamano de un panel junto al hueco para llenarlo.
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[ Separacion entre paneles I [ Separacidn entre escenas I

De esta manera, el modo de edicién de animatica hace que el flujo de trabajo en Storyboard Pro sea mas
parecido al de un software tipico de edicidn de video, lo cual puede facilitar la edicidn a los usuarios que estén
familiarizados con este tipo de aplicaciones.

Cambio al modo de edicidn de animatica

1. En la esquina inferior izquierda de la vista de linea de tiempo, haga clic en el botdn Animatic Editing
Mode (Modo de edicién de animatica) -

2. Una vez que haya terminado de usar el modo de edicién de animatica, solo tiene que hacer clic de
nuevo en el botdn para deshabilitarlo.

Q_ CONSEJOS

e Cuando el modo de edicién de animatica esté desactivado, puede mantener pulsada la
tecla Ctrl (Windows) o 8 (macOS) para habilitar temporalmente el modo de edicién de
animatica mientras realiza cambios en la animatica. Del mismo modo, cuando el modo de
edicién de animatica esté habilitado, se deshabilitard temporalmente al mantener pulsada
la tecla Ctrl (Windows) o # (macOS).

» También puede asignar un atajo de teclado al comando Toggle Animatic Editing Mode
(Alternar modo de edicién de animatica) en la seccién Storyboard del cuadro de didlogo
Keyboard Shortcuts (Atajos de teclado), que lo alterna pulsando la tecla, sin necesidad de
mantenerla pulsada.
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Ajuste del punto de entrada de un panel en modo de edicién de animatica

1. Coloque el cursor cerca del borde izquierdo del panel.

Se muestra el icono de cambio de tamano [I. Aseglrese de que apunta hacia el interior del panel
que desea editar.

2. Hagaclicy arrastre el borde hacia la derecha para mover el punto de entrada hacia delante, o hacia
la izquierda para moverlo hacia atrés.

[ Mueva longitud del panell [Diferencia de longitud I

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o
resta al mismo.

NOTA

No puede mover el punto de entrada de un panel o escena antes del punto de salida del panel
0 escena anterior.
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Ajuste del punto de salida de un panel en modo de edicién de animatica

1. Coloque el cursor cerca del borde derecho del panel.

Se muestra el icono de cambio de tamano 1] . Aseglrese de que apunta hacia el interior del panel
que desea editar.

2. Haga clicy arrastre el borde hacia la izquierda para mover el punto de salida hacia atras, o hacia la
derecha para moverlo hacia delante.

[ Mueva longitud del panell [Diferencia de longitudl

A medida que lo arrastra, se indica la nueva longitud del panel y la cantidad de tiempo que suma o
resta al mismo.

NOTA

No puede mover el punto de salida de un panel o escena mds alld del punto de entrada del
siguiente panel o escena.
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Como eliminar paneles y dejar un hueco en la linea de tiempo en el modo de edicién
de animatica

1. Seleccione los paneles que desee eliminar.

_‘Q'_ CONSEJOS
¢ Puede seleccionar varios paneles manteniendo pulsada la tecla Ctrl (Windows) o
(macOS) y haciendo clic en cada panel que desee eliminar.
¢ Puede seleccionar una secuencia de varios paneles haciendo clic en el primer panel
que desee seleccionar y, mientras mantiene pulsada la tecla Mayus, haciendo clic en
el Ultimo panel que desee seleccionar. Todos los paneles intermedios se

seleccionaran.

2. Realice una de las siguientes acciones:
» Haga clic con el botén derecho en la seleccidn y seleccione Clear Panels (Borrar paneles).
* En el mend superior, seleccione Edit > Clear Panels (Editar > Borrar paneles).
e Pulse Supr (Windows) o X (macQS).

Los paneles seleccionados se eliminaran y quedard un espacio en su lugar.

En el modo de edicién de animatica, los paneles no se propagan hacia delante o hacia atras, lo cual puede ser
limitante. Para sacar el maximo provecho del modo de edicién de animatica, es Util saber cdmo propagar los

paneles sobre la marcha.

En cualquier momento, puede mantener pulsada la tecla Ctrl (Windows) o0 8 (macOS) antes de editar la
animatica para habilitar o deshabilitar temporalmente el modo de edicién de animatica. Esto significa que,
cuando el modo de edicién de animatica estd habilitado, si mantiene pulsada la tecla Ctrl (Windows) o
(mac0S), lo desactivara temporalmente y cualquier cambio que realice en la animatica mientras mantenga
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pulsada esta tecla desplazara todos los paneles después del panel afectado. Si hay huecos en la linea de
tiempo, también se propagan hacia delante o hacia atras.

Si necesita crear un hueco o ajustar el tamafo de un hueco, puede hacerlo seleccionando todos los paneles

desde un punto especifico hasta el final de la animatica vy, a continuacidn, moviendo la seleccidn.

Seleccidn y propagacién de todos los paneles desde un punto especifico de la
animatica en el modo de edicidn de animatica

1. Mantenga pulsadas las teclas Ctrl (Windows) o 8 (macOS), Alty Mayus.

2. Mientras mantiene pulsadas dichas teclas, en la vista de linea de tiempo, haga clic en el primer
panel de la secuencia de paneles que desee desplazar.

Se seleccionara el panel en el que hizo clic y todos los paneles posteriores hasta el final de la
animatica.

3. Hagaclicy arrastre la seleccién para desplazarla.

[ Nueva longitud de la anima’tical [Compensacic’m I

Adicidn de transiciones

Las transiciones son efectos animados que se pueden agregar entre dos escenas para pasar de una escena a la
siguiente gradualmente, como un fundido o un barrido de bordes. Entre otras cosas, la adicién de transiciones
puede ayudar a ajustar el ritmo entre las escenas o0 a marcar cambios en la configuracidn de la historia.
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Adicién de una transicion

1. En lavista de imdgenes en miniatura o de linea de tiempo, seleccione la primera de las dos escenas
entre las que desee agregar una transicion. Por ejemplo, si desea agregar una transicion entre las
escenas 2y 3, seleccione cualquier panel de la escena 2.

RR_Line01_Celina_0

[ Primera escena de transicion I [ Segunda escena de transicion I

2. Realice una de las siguientes acciones:

* En la barra de herramientas Storyboard, haga clic en el botén New Transition (Nueva
transicion) #X .

» Seleccione Storyboard > Add Transition (Storyboard > Agregar transicion).

» Haga clic con el botén derecho en las imagenes en miniatura de la escena y seleccione Add

Transition (Agregar transicion).

N PO

RR_Line01_Celina_01.way

Transicion

3. Haga clic en la transicién para seleccionarla.

4. Abra la vista de panel. Al seleccionar una transicidn, la vista de panel muestra sus propiedades y
permite cambiarlas.

5. En la lista desplegable Type (Tipo), seleccione qué tipo de transicidn desea utilizar:

* Dissolve (Fundido): Hace que la primera escena se desvanezca a negro y que la segunda
aparezca gradualmente del negro.

» Edge Wipe (Barrido de bordes): Barre la primera escena con la segunda con una linea recta
que atraviesa la pantalla. EL angulo de la linea se puede personalizar.
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» Clock Wipe (Barrido en reloj): Barre la primera escena con la segunda con una linea que va
del centro de la pantalla a su borde y que gira 360 grados para cubrir toda la pantalla. El
angulo y la direccidn iniciales de la linea se pueden personalizar.

» Slide (Deslizar): Cuando se establece en Slide In (Deslizar acercando), la segunda escena se
desliza desde el borde de la pantalla sobre la primera escena. Cuando se establece en Slide
Out (Deslizar alejando), la primera escena se desliza hacia el borde de la pantalla, dejando la
segunda escena en la pantalla como si siempre hubiera estado detras de ella. El angulo al
que la escena se desliza acercando o alejando se puede personalizar.

6. Determine la duracidn de la transicidn realizando una de las siguientes acciones:

» En la vista de linea de tiempo, haga clic y arrastre el borde derecho de la transicién hacia la
derecha para ampliarlo o hacia la izquierda para reducirlo.

* En la vista de panel, a la derecha del campo de duracién, haga clic en la flecha arriba 4 para
ampliar la transicidn un fotograma o en la flecha abajo ¥ para reducir la transicién un
fotograma.

» En el campo de duracidn de la vista de panel, escriba la duracién de la transicién.

NOTA

El formato de la duracidn es H:MM: SS : FF, donde H significa horas, M significa
minutos, S significa segundos y F significa fotogramas.

NOTA

Al ampliar una transicidn, se propagara hacia atras en las escenas resultantes, y al
reducirla, se propagara hacia delante en las escenas resultantes. Esto se debe a que las
escenas previas y posteriores a la transicion se superponen durante la transicion. Por
tanto, la escena posterior a la transicién comienza, mientras que la escena anterior a la
transicion adn no ha finalizado, lo que reduce la duracién del proyecto.
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Capitulo 11: Animacion de la camara

Para crear movimiento de la cdmara en una escena, debe comenzar creando al menos dos fotogramas clave de
camaray, a continuacion, establecer la posicion de la camara en cada uno de esos fotogramas clave.
Storyboard Pro interpolara la posicidn de la cdmara en cada fotograma entre dos fotogramas clave.

Animacion de la cdmara en una escena

1. Seleccione la herramienta Camera (Camara) realizando una de las siguientes acciones:

* En la barra de herramientas de herramientas, seleccione la herramienta Camera (Camara)

)
1P o

* En el mend superior, seleccione Tools > Camera (Herramientas > Camara).

2. En lavista de linea de tiempo, haga clic y arrastre el cursor de la linea de tiempo hasta el fotograma
en el que desea que comience el movimiento de la camara.

3. Cree un fotograma clave de camara realizando una de las siguientes acciones:

» En la vista de linea de tiempo, en la columna izquierda de la pista de camara, haga clic en el
botdon Add Keyframe (Agregar fotograma clave) +

* En el mend superior, seleccione Camera > Add Camera Keyframe at Current Frame
(Céamara > Agregar fotograma clave de camara al fotograma actual).

» En la vista de propiedades de la herramienta, haga clic en el botdon Add Keyframe (Agregar
fotograma clave) ¢r del panel Camera Transform (Transformacién de cdmara).

Se agrega un fotograma clave en la pista de cdmara de la vista de linea de tiempo donde se
encuentre el cursor de la linea de tiempo.

4. En la vista de linea de tiempo, haga clic y arrastre el cursor de la linea de tiempo hasta el fotograma
en el que desea que finalice el movimiento de la camara.

5. Cree un fotograma clave de cdmara realizando una de las siguientes acciones:

» En la vista de linea de tiempo, en la columna izquierda de la pista de camara, haga clic en el
botén Add Keyframe (Agregar fotograma clave) =f=.

* En el mend superior, seleccione Camera > Add Camera Keyframe at Current Frame
(Camara > Agregar fotograma clave de camara al fotograma actual).
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» En la vista de propiedades de la herramienta, haga clic en el botén Add Keyframe (Agregar
fotograma clave) ¢r del panel Camera Transform (Transformacién de cdmara).

Se agrega otro fotograma clave en la pista de camara de la vista de linea de tiempo donde se
encuentre el cursor de la linea de tiempo.

6. Realice una de las siguientes acciones:

» En la pista de camara de la vista de linea de tiempo, seleccione el fotograma clave de la

camara que desea modificar.

» En la vista de escena o de cdmara, aleje la vista para ver todos los fotogramas de la cdmara.
A continuacién, seleccione el fotograma de la cdmara que desea modificar haciendo clic en

su borde o su punto central.
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:Q'. CONSEJO

4 \

Incluso si los fotogramas de la cdmara se encuentran en la misma posicion, puede
seleccionar uno especifico en la vista de escena o de camara. Justo debajo de la esquina
inferior izquierda de los fotogramas de la cdmara encontrara puntos azules con forma
cuadrada. Se puede hacer clic en cada uno de estos puntos para seleccionar un
fotograma de camara especifico. Si dos o mas fotogramas clave de la camara se
encuentran en la misma posicidn, el orden de estos puntos representara su posicién
relativa en la linea de tiempo. El punto situado mas a la izquierda se puede utilizar para
seleccionar el primer fotograma clave de la camara, el segundo punto situado mas a la
izquierda se puede utilizar para seleccionar el segundo fotograma clave de la camara,
etc.

Primer fotograma Tercer fotograma clave
clave de cdmara de cdmara

[ Segundo fotograma clave de camara ]

7. Utilice uno de los siguientes métodos para modificar el fotograma de la cdmara:

* Mover: Mueva el cursor del ratén sobre el borde o el punto central del fotograma de la
cédmara hasta que el cursor se convierta en +}+ vy, a continuacion, haga clic y arrastre el
fotograma de la cdmara para moverlo.
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» Aproximar o retirar: Mueva el cursor del ratén sobre el punto situado en la esquina superior
izquierda del fotograma de la camara hasta que el cursor se convierta en {;— y,a
continuacién, haga clic y arrastre esta esquina para contraer o estirar el fotograma de la
camara. Al contraer el fotograma de la camara, lo acercara, y al estirarlo, lo alejara.

* Rotar: Mueva el cursor del ratdn fuera de una de las esquinas del fotograma de la camara
hasta que el cursor se convierta en O y, a continuacion, haga clic y arrastre la esquina en
cualquier direccién para rotar el fotograma de la cdmara a la derecha o a la izquierda.

:Q’. CONSEJO

También puede realizar un desplazamiento pequerio del fotograma de la camara
utilizando las teclas de flecha del teclado o introducir sus coordenadas exactas en la
vista de propiedades de la herramienta.

8. Repita estos pasos para los demas fotogramas clave de la cdmara, si es necesario.
9. Desplace el cursor de la linea de tiempo al principio de la escena.

10. En la barra de herramientas de reproduccidn, haga clic en el botdn Play (Reproducir) » para
obtener una vista previa del movimiento de la camara.
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Capitulo 12: Animacion de capas

De forma predeterminada, las capas de Storyboard Pro son estéticas, pero se pueden animar.

Una capa se anima mediante su configuracién en distintas posiciones, angulos o tamafios en dos fotogramas
diferentes en la linea de tiempo y, a continuacion, permitiendo que Storyboard Pro calcule la posicidn, el
angulo y el tamafio de la capa de cada fotograma entre esos dos fotogramas. Los fotogramas al principio y al
final de una animacién se conocen como fotogramas clave.

Puede animar una capa habilitando la animacién en ella, accidn que creard un fotograma clave en su posicién
actual en el fotograma actual. A partir de ahi, puede ir a otro fotograma y cambiar su posicidn, accién que
creard automaticamente otro fotograma clave en el fotograma actual. En este punto, la capa ya estd animada
desde su posicién original hasta la posicidn a la que la acaba de mover.

Animacioén de una capa

1. En la vista de linea de tiempo, seleccione el panel con la capa que desea animar.

2. Mueva el cursor de la linea de tiempo al momento exacto en el que desea crear el primer fotograma
clave de la animacidn.

3. Enel panel Layer (Capa) de la vista de escena o de camara, haga clic en el botén Animate (Animar)
7 del objeto 3D que desea animar.

El botén Animate (Animar) cambia a color amarillo y también cambia de forma.

Botdn
Animate
[Animar)

O H# O E E L O ee B

En la pista de animacién de capa de la vista de linea de tiempo se crea un fotograma clave en el
fotograma actual. Este fotograma clave almacena la posicion, el angulo y el tamafio de la capa en
el fotograma actual.
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4. En la barra de herramientas de herramientas, seleccione la herramienta Layer Transform
(Transformacion de capas) i.}.

En la vista de escena o de camara, los controles de la herramienta Layer Transform
(Transformacion de capas) aparecen alrededor de la capa de dibujo seleccionada.

[ Escalar verticalmente Io4R0tar I

[ Escalar horizontalyver‘ticalmentel'—' - "—[ Escalar horizontalyver‘ticalmentel

[ Escalar horizontalmente I'—l '—[ Escalar horizontalmente I

i Punto de pivote I

[ Escalar horizontal y verticalmente ' -I- - {Escalar horizontalyver‘ticalmentel

Rotar [ Escalar verticalmente I Rotar I

[ Cuadro delimitador de la herramienta de transformacion en una capa de dibujo y sus controles I

5. Mediante el cuadro del manipulador, transforme la capa para que tenga la posicidn, el angulo y el
tamano que desee al comienzo de la animacion:

» Para mover la capa, haga clic en su ilustracion o en el punto azul en el centro y, a
continuacidn, arrastrela a la posicién deseada.
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CONSEJOS

» Sitiene problemas para arrastrar la capa por su ilustracién, también puede
hacer clic y arrastrar el punto azul ® del centro. Sin embargo, este punto
puede estar obstruido por el punto de pivote ® dela capa. Si es el caso,
puede hacer clic y arrastrar el punto de pivote para apartarlo del camino y, a
continuacidn, hacer clic y arrastrar el punto central para mover la capa.

* También puede desplazar un poco la seleccién mediante las teclas de flecha
del teclado.

* También puede escribir coordenadas especificas en los campos Horizontal
Offset (Desplazamiento horizontal) <>_<, y Vertical Offset (Desplazamiento
vertical) Y} de la vista de propiedades de la herramienta.

e Para escalar la capa, haga clic en uno de los cuadrados de los bordes o esquinas del cuadro
del manipulador y arrastrelo para estirar o contraer el dibujo.

CONSEJOS

» Puede conservar las proporciones horizontal y vertical de la seleccién si

mantiene pulsada la tecla Mayus.

» También puede escribir porcentajes de escala especificos en los campos
Horizontal Scale (Escala horizontal) [ y Vertical Scale (Escala vertical) [
de la vista de propiedades de la herramienta.

e Para rotar la capa, mueva el cursor fuera de una de las esquinas del cuadro del manipulador
hasta que el cursor del ratén se convierta en (. A continuacién, haga clicy arrastre en
cualquier direccion para rotar la capa a la derecha o a la izquierda.
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.:Q:. CONSEJOS
e Puede rotar la ilustracion en incrementos de 15° si mantiene pulsada la tecla
Mayus.
» También puede introducir un angulo especifico en grados en el campo Angle
(Angulo) (2 de la vista de propiedades de la herramienta.

e También puede rotar el clip en incrementos de 90° haciendo clic en el botén
Rotate 90 CW (Rotar 90 derecha) (@ en la vista de propiedades de la
herramienta para rotarlo 90° a la derecha, o en el botén Rotate 90 CCW
(Rotar 90 izquierda) ¥) para rotarlo 90° a la izquierda.

» Para voltear la capa en horizontal, haga clic en el botdn Flip Horizontally (Voltear en
horizontal) S|2 de la vista de propiedades de la herramienta.

 Para voltear la capa en vertical, haga clic en el botén Flip Vertically (Voltear en vertical) <=
de la vista de propiedades de la herramienta.

» Para restablecer una capa a su posicion, escala y angulo originales, realice una de las
siguientes acciones:

» Seleccione Layer > Reset Transform (Capa > Restablecer transformacion).

¢ Pulse Ctrl + R (Windows) o # + R (macQS).

6. En la vista de linea de tiempo, mueva el cursor al fotograma en el que desea crear el segundo
fotograma clave.
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7. Enla vista de escena o de camara, utilice el cuadro del manipulador para transformar la capa de
modo que tenga la posicién, el angulo y el tamafo que desea que tenga al final de la animacion.

Se crea un fotograma clave en el fotograma actual al realizar la primera transformacion.

8. Desplace el cursor de la linea de tiempo al principio del panel.

9. Enla barra de herramientas de reproduccién, haga clic en el botén Play (Reproducir) » para
obtener una vista previa de la animacién.
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Capitulo 13: Importacion de audio

Puede agregar sonido a la animatica. Una animatica puede tener una o varias pistas de audio, y cada pista de
audio puede tener uno o varios archivos de sonido en diferentes momentos del proyecto.

Como habilitar el sonido

De forma predeterminada, el sonido se deshabilita en Storyboard Pro. Debe habilitar el sonido para poder

escuchar el audio del proyecto durante la reproduccion.

Habilitacion o deshabilitacion de la reproducciéon de audio

1. Realice una de las siguientes acciones:
» En la barra de herramientas de reproduccion, haga clic en el botén Sound (Sonido) «.

* En el mend superior, seleccione Play > Audio Playback (Reproducir > Reproduccién de

audio).

La proxima vez que reproduzca la animatica, escuchara la reproduccién de los clips de sonido de

sus pistas de audio.

Importacion de clips de sonido

Puede importar archivos de sonido en la pista de audio en la linea de tiempo del proyecto. Puede preparary
editar clips de sonido para que se sincronicen con la accion en la animatica. De manera predeterminada, el
proyecto tiene una sola pista de audio, pero se pueden agregar mas pistas de audio seguin sea necesario.

Importacion de un clip de sonido

1. En la vista de linea de tiempo, seleccione la pista de audio en la que desea importar los clips de

sonido.
2. Realice una de las siguientes acciones:

* En el mend superior, seleccione File > Import > Sound Clip (Archivo > Importar > Clip

de sonido).

» Haga clic con el botdn derecho en la pista de audio en la que desee importar clips de
sonido y, a continuacidn, seleccione Import Sound Clips (Importar clips de sonido).

» Haga clic con el botén derecho en el espacio vacio situado debajo de las pistas en la
vista de linea de tiempo y, a continuacidn, seleccione Import Sound Clips (Importar

clips de sonido).

Se abre el cuadro de dialogo Import Sound Clips (Importar clips de sonido).
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3. Hagaclic en el botdn Browse (Examinar) 77.

4. En el buscador de archivos, localice y seleccione el archivo de sonido que desee agregar a su
proyecto y haga clic en Open (Abrir).

5. En el panel Target Audio Track (Pista de audio de destino), seleccione New Audio Track (Nueva
pista de audio) si desea crear una nueva pista de audio e importar el archivo de sonido en ella, o
Current Audio Track (Pista de audio actual) si desea importar el archivo de sonido en la pista de
audio seleccionada.

6. En la seccidn Target Frame (Fotograma objetivo), seleccione si desea agregar el clip de sonido al
First Frame (Primer fotograma) de la pista de audio o al Current Frame (Fotograma actual), donde
se encuentra el cursor de la linea de tiempo.

7. Siha seleccionado la opcién Current Audio Track (Pista de audio actual) y si hay otros clips de
audio en la pista de sonido de destino, especifique qué ocurrira si el clip de sonido importado es
demasiado largo y se expande a otro clip de sonido existente al seleccionar una Import Rule (Regla
de importacidn):

¢ Overwrite Existing Sound Clips (Sobrescribir clips de sonido existentes): Si ya hay clips de
sonido donde se supone que se deben agregar los clips importados, los clips existentes se
sobrescribiran.

* Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): Si ya hay clips de
sonido donde se supone que se deben agregar los nuevos clips, los clips se ajustaran justo
antes de los clips existentes.

8. Seleccione la opcion Set as default and don’t show dialogue again (Establecer como
predeterminado y no volver a mostrar el didlogo) si desea utilizar la misma configuracion la
proxima vez que necesite importar un archivo de sonido.

9. Haga clic en OK (Aceptar).

Los archivos de sonido seleccionados se afiadiran al proyecto como clips de sonido en la pista de
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audio de destino seleccionada y en la posicidn seleccionada.

Importacion de clips de sonido con arrastrar y colocar

1. Abra la ventana del Explorador (Windows) o el Finder (macQS).

2. Busque la ubicacion de los elementos de archivos de sonido que desee exportar.

3. Seleccione todos los elementos de archivos de sonido que desee importar.
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_‘Q'. CONSEJO
Puede seleccionar varios archivos mediante una de las siguientes acciones:

e Mientras pulsa Ctrl (Windows/Linux) o ¥ (macOS), haga clic en cada uno de los
archivos que desee seleccionar.

» Mientras pulsa Mayus, haga clic en el primer archivo que desee seleccionary, a
continuacidn, en el ultimo archivo que desee seleccionar para seleccionar todos los
archivos intermedios.

4. Asegurese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder
estén visibles.

5. En la mitad inferior de la vista de linea de tiempo, despldcese verticalmente hasta la pista de audio
en la que desea insertar los clips de sonido y, a continuacidn, desplacese horizontalmente hasta el
punto en el que desea insertar los clips de sonido.

6. En la ventana del Explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados.
Después, coldquelo en la pista de audio donde desee importarlo y en el momento en el que desee
importarlo.

s ThaPC » Documenss » Veice Dverm

FR_Linu0_Coln
R Linedl_Celn

FR_LinaCt_Coln
FR_Lingd2 T,
FR_Linall Cor_
PR Linea_Toman.
PR Ll Cor_

P Line0_Terwan.

Los clips de sonido seleccionados se afiadiran a la pista de audio de destino en el punto de la linea
de tiempo en el que los colocd.

Adicion de pistas de audio

Si necesita reproducir varios clips de sonido al mismo tiempo, debe agregar pistas de audio adicionales al
proyecto para poder preparar varios clips de sonido en las mismas areas de la linea de tiempo.
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Adicién de una pista de audio

1. Realice una de las siguientes acciones:

* En el mend superior, seleccione Storyboard > New > New Audio Track (Storyboard >
Nuevo > Nueva pista de audio).

» En la vista de linea de tiempo, haga clic con el botdn derecho en una pista de audio existente
o debajo de todas las pistas y seleccione New Audio Track (Nueva pista de audio).

» En la barra de herramientas de clips y pistas, haga clic en el botén New Audio Track (Nueva
pista de audio) %.

Ya puede importar o mover clips de sonido a la nueva pista de audio.
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Capitulo 14: Importacion de videos

Al crear un proyecto de Storyboard Pro, la Unica pista destinada a contener imdgenes en la animatica es la
pista del storyboard. Sin embargo, también puede agregar pistas de video al proyecto, que puede contener
imagenes fijas o archivos de video que se mostrardn por encima o por debajo de la animdtica. Esto puede ser
util si necesita utilizar imagenes o videos de referencia para que elementos, como logotipos o fondos, se
expandan por varios paneles o escenas, o para insertar en la animatica videos, como secuencias de apertura,
secuencias de créditos o material de accidn en vivo.

A diferencia de las capas de un panel, los clips de las pistas de video pueden abarcar varios paneles y no se
ven afectados por los movimientos de la camara.

Adicion de pistas de video

Aligual que los clips de sonido se deben afnadir a las pistas de audio, los clips de video se deben afiadir a las
pistas de video. Por lo tanto, antes de que pueda agregar clips de video a la animatica, debe crear pistas de
video.

Aligual que las pistas de audio, puede agregar varias pistas de video al proyecto y hacer que los clips se
superpongan entre si. También puede agregar pistas de video encima o debajo de la pista del storyboard para
que los videos aparezcan delante o detras de la animatica.

Adicién de una pista de video

1. Realice una de las siguientes acciones:

* En el mend superior, seleccione Storyboard > New > New Video Track (Storyboard >
Nuevo > Nueva pista de video).

» En la vista de linea de tiempo, haga clic con el botdn derecho en una pista de video existente
o en el espacio vacio que se encuentra por debajo de las pistas, y seleccione New Video
Track (Nueva pista de video).

» En la barra de herramientas Clips and Tracks (Clips y pistas), haga clic en el botén New
Video Track (Nueva pista de video) &Em.

Ya puede importar o mover clips de video a la nueva pista de video.
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2. Sidesea que la pista de video se muestre detras de la animatica, haga clic con el botdn derecho en
la pista de video y seleccione Move Track Down (Bajar pista).

Importacion de clips de video

Una vez que tenga una pista de video, puede importar clips de imagen o video a esta pista.

Importacion de un clip de video o de imagen utilizando el cuadro de didlogo Import
Videos/Images (Importar videos/imagenes)

1. Sideseaimportar clips en una pista de video existente, seleccione la pista de video en la que desee
importar clips en la vista de linea de tiempo.

2. Realice una de las siguientes acciones:

* En el mend superior, seleccione File > Import > Videos/Images as Clip (Archivo > Importar
> Videos/imagenes como clip).

» Haga clic con el botén derecho en la pista de video en la que desee importar clips y, a
continuacion, seleccione Import Videos/Images as Clips (Importar videos/imagenes como

clip).

» Haga clic con el botén derecho en el espacio vacio situado debajo o encima de las pistas en
la vista de linea de tiempo vy, a continuacion, seleccione Import Videos/Images as Clips
(Importar videos/imagenes como clip).

Se abre el cuadro de didlogo Import Video Clips (Importar clips de video).
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3. Hagaclic en el botén Browse (Examinar) 7.

4. En el explorador de archivos, localice y seleccione el archivo de imagen o video que desee agregar
a su proyecto y, a continuacién, haga clic en Open (Abrir).

5. En el panel Destination (Destino), seleccione New Video Track (Nueva pista de video) si el
proyecto no tiene una pista de video o si desea importar el clip en una nueva pista de video, o
Current Video Track (Pista de video actual) si desea importarlo en la pista de video actualmente
seleccionada.

6. Siha seleccionado unaimagen, establezca la duracién deseada de la imagen fija en el campo Still
Images Duration (Duracidén de imdgenes estaticas). Esto determina la cantidad de fotogramas por
los que se expandira el clip de imagen en la linea de tiempo. Por ejemplo, si los fotogramas por
segundo del proyecto son 24 y desea que la imagen abarque 1 segundo, defina 24 en Clips
Duration (Duracidn de clips).

7. Siha seleccionado un archivo de pelicula con transparencia, seleccione el tipo de alfa adecuado
para el mismo en la lista desplegable Alpha Type (Tipo de alfa):

Esta opcidn le permite informar a Storyboard Pro de cdmo se han codificado los pixeles
transparentes y semitransparentes de su clip para que se mezclen adecuadamente con los demas
elementos visuales de su animatica.

 Ignore Alpha (Ignorar alfa): Mostrar cada pixel del clip de video como opaco, sin
desmultiplicar sus valores de color o mezclarlos con otros elementos visuales de la
animatica.

* Premultiplied with Black (Premultiplicado con negro): Los valores de color de los pixeles
semitransparentes del video se han codificado de modo que, cuanto mds transparentes
sean, mas cercanos al negro estaran. Cuando se carga un video premultiplicado con negro
en un software que no admite transparencia, aparece combinado con un fondo negro.
Seleccione esta opcidn para hacer que Storyboard Pro revierta esta premultiplicacion de
modo que el video se combine correctamente con otros elementos visuales de la animatica.

* Premultiplied with White (Premultiplicado con blanco): Los valores de color de los pixeles
semitransparentes del video se han codificado de modo que, cuanto mas transparentes
sean, mas cercanos al blanco estaran. Cuando se carga un video premultiplicado con blanco
en un software que no admite transparencia, aparece combinado con un fondo blanco.
Seleccione esta opcidn para hacer que Storyboard Pro revierta esta premultiplicacidn de
modo que el video se combine correctamente con otros elementos visuales de la animatica.

» Straight (Recto): El color de los pixeles semitransparentes en la imagen se codifica
independientemente de su transparencia. Cuando se carga un clip de video que no esta
premultiplicado en un software que no admite transparencia, los pixeles semitransparentes
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8.

10.

simplemente aparecen completamente opacos, lo cual hace que sus bordes parezcan
pixelados.

CONSEJO

Si no sabe con seguridad el tipo de alfa del archivo de pelicula, seleccione Straight
(Directo). A continuacion, una vez importados los clips, véalos en la vista de escena. Si
los pixeles transparentes de la pelicula parecen demasiado oscuros, cambie el tipo de
alfa del clip a Premultiplied with Black (Premultiplicado con negro). Si los pixeles
transparentes de la pelicula parecen demasiado claros, cambie el tipo de alfa del clip a
Premultiplied with White (Premultiplicado con blanco).

Puede cambiar el tipo de alfa de un clip de video haciendo clic con el botdn derecho en
el clip en la vista de linea de tiempo vy, a continuacidn, seleccionando Alpha Type (Tipo
de alfa) en el menu contextual.

Si el archivo de pelicula tiene una pista de audio y desea importarla en el proyecto, active la casilla
de verificacién Import Audio (Importar audio).

Si ha activado la casilla de verificacion Import Audio (Importar audio), realice una de las siguientes
acciones:

* Sidesea crear una nueva pista de audio en el proyecto en la que importar la pista de audio
de la pelicula, seleccione New Audio Tracks (Nuevas pistas de audio).

» Sideseaimportar la pista de audio de la pelicula en una pista de audio existente en el
proyecto, seleccione Existing Audio Track (Pista de audio existente). A continuacion, en la
lista desplegable situada debajo, seleccione en qué pista de audio del proyecto desea
importar la pista de audio de la pelicula.

Si ha seleccionado la opcion Current Video Track (Pista de video actual) y si hay otros clips de
video en la pista de video de destino, especifique qué ocurrird si el clip de video importado es
demasiado largo y se expande por otros clips existentes al seleccionar una Import Rule (Regla de
importacion):

» Overwrite Existing Clips (Sobrescribir clips existentes): Si ya hay clips de video donde se
insertan los clips importados, los clips existentes se sobrescribiran.
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» Fill Next Available Frames (Rellenar siguientes fotogramas disponibles): Si ya hay clips de

video donde se insertan los nuevos clips, los clips se ajustaran justo antes de los clips
existentes.

11. Hagaclic en OK (Aceptar).

El archivo de video se afiadird al proyecto como un clip de video en la pista de video de destino
seleccionada.

Rocket_Rodeo_Opening.mov

Importacion de clips de video o de imagen con arrastrar y colocar

1. Abra la ventana del Explorador (Windows) o el Finder (macQS).
2. Busque la ubicacion de los elementos de archivos de video o de imagen que desee exportar.

3. Seleccione todos los elementos de archivos de video o de imagen que desee importar.
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4

_‘Q'. CONSEJO
Puede seleccionar varios archivos mediante una de las siguientes acciones:

e Mientras pulsa Ctrl (Windows/Linux) o ¥ (macOS), haga clic en cada uno de los
archivos que desee seleccionar.

» Mientras pulsa Mayus, haga clic en el primer archivo que desee seleccionary, a
continuacidn, en el ultimo archivo que desee seleccionar para seleccionar todos los
archivos intermedios.

4. Asegurese de que tanto la ventana de Storyboard Pro como la ventana del Explorador o el Finder
estén visibles.

5. En la mitad superior de la vista de Timeline (Linea de tiempo), desplacese verticalmente a la pista
de video en la que desea importar sus clips. A continuacién, desplacese horizontalmente hasta el
punto en el que desee insertar estos clips.

6. En la ventana del explorador o del Finder, haga clic y arrastre uno de los archivos seleccionados.
Después, coldquelo en la pista de audio donde desee importarlo y en el momento en el que desee
importarlo.

Los archivos seleccionados se afadiran como clips de video a la pista de video de destino en el
punto de la linea de tiempo en el que los colocé.
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Capitulo 15: Trabajo en 3D

Storyboard Pro permite manipular capas de dibujo en el espacio 3D e integrar modelos 3D en el storyboard. Si
el proyecto utiliza modelos 3D, puede importarlos en el proyecto y, a continuacion, insertarlos en los paneles
en lugar de tener que dibujarlos.

Conversidn de una escena en 3D

Al crear una escena, se crea en modo 2D de forma predeterminada. Esto significa que las capas estan
blogueadas en la misma posicién en el eje z y solo se pueden rotar sobre el eje z. De este modo se evita
obstaculizar el flujo de trabajo con funciones 3D que no son necesarias.

Puede convertir facilmente una escena 2D a 3D, y viceversa. En una escena 3D, puede mover capas en el gje z
y rotarlas en cualquier direccién. También puede rotar la cdmara en cualquier direccion y hacer que se mueva a
través de la profundidad de la escena. Del mismo modo, puede rotar la vista de escena en cualquier angulo y
desplazarse por la escena detenidamente, lo que le permite verla desde diversos puntos de vista.

NOTA

Puede convertir una escena en 3D, pero no un solo panel. Al cambiar al modo 3D, este solo se
aplica a la escena actual, no a todo el proyecto.

Activacion de la opcion 3D

1. En lavista de imdgenes en miniatura o de linea de tiempo, seleccione la escena que desea convertir
en 3D.

2. Realice una de las siguientes acciones:

* En la barra de herramientas de storyboard, haga clic en el botén Enable 3D (Habilitar 3D)

0]

e Seleccione Storyboard > Enable 3D for Current Scene (Storyboard > Habilitar 3D para
escena actual).

Restablecimiento de una escena a 2D
Puede restablecer una escena 3D a 2D. Al hacerlo, se realizan los siguientes cambios en la escena:
¢ Se eliminan los modelos 3D importados.

e Los movimientos de cdmara 3D se convierten en movimientos de cdmara 2D. Los movimientos de la
camara en el eje z se convertiran en acercamientos y alejamientos de la cdmara 2D, pero se ignoraran
las rotaciones 3D.
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¢ Lastransformaciones 3D en capas se convierten en transformaciones 2D. Las capas que se han movido
en el eje z aumentaran o disminuiran de tamafio para conservar sus proporciones aparentes, pero se
ignoraran las rotaciones 3D.

Restablecimiento de una escena a 2D

1. Realice una de las siguientes acciones:

» En la barra de herramientas Storyboard, haga clic en el botén Reset Scene to 2D
(Restablecer escena a 2D) 2D.

e Seleccione Storyboard > Reset Scene to 2D (Storyboard > Restablecer escena a 2D).

Visualizacion de objetos desde la parte superior y lateral

Al trabajar en 3D, se puede utilizar la vista de escena para mirar la escena desde cualquier punto de vista y
desde cualquier angulo. Esto permite ver como estan colocados los objetos en el espacio, y puede utilizar la
vista de cdmara para ver la escena desde el punto de vista de la cdmara. Sin embargo, es probable que a
menudo necesite tener un control preciso sobre cdmo se colocan los objetos y las capas en el eje z.

Las vistas superior y lateral permiten ver la escena desde su parte superior y lateral, respectivamente. Dado
que estas vistas no aplican perspectiva a la escena, se pueden utilizar para colocar elementos con mas
precision. Con la vista lateral, puede ver y colocar capas y objetos en el eje delantero-trasero (z), asi como en
el eje norte-sur (y). Con la vista superior, puede ver y colocar capas y objetos en el eje delantero-trasero (z), asi
como en el eje este-oeste (x). Por lo tanto, ambas vistas combinadas pueden ayudar a colocar objetos en el eje
z sin perder de vista su posicién en los otros ejes.
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Cada elemento de asta escena se encuantra ubicado en una posicién diferente en el espacio 3D, como se indica en las vistas superior  lateral.

Las vistas superior y lateral muestran capas 2D como segmentos finos, como si estuviera mirando las hojas de
papel desde un lateral. Puede seleccionar y manipular capas 2D de forma manual directamente desde estas
vistas.
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Visualizacion de las vistas superior o lateral

» En la esquina superior derecha de cualquier vista, haga clic en el botdn == Add View (Agregar
vista) y seleccione Side View (Vista lateral) o Top View (Vista superior).

e En el menu superior, seleccione Windows > Side View (Ventanas > Vista superior) o Top View
(Vista lateral).

Colocacion de elementos 2D en el espacio 3D

En una escena 3D, las capas de dibujo se pueden manipular como objetos 3D. Puede colocarlas mas cerca o
mas lejos de la camara para crear un efecto de multiplano. También puede rotarlas en cualquier direccidn para
realizar falsas construcciones 3D, como habitaciones abiertas.

Colocacion de un elemento 2D en el espacio 3D

1. En la barra de herramientas de herramientas, seleccione el botdn Layer Transform (Transformacién
de capas) 1.

2. Enla vista de escena, seleccione el elemento que desea cambiar de lugar.

Aparece un manipulador de transformacién 3D sobre la capa en las vistas de escena, camara,
superior y lateral.

3. Este manipulador 3D tiene una flecha azul en la que puede hacer clic y arrastrarla para mover la
capa en el gje z. Sin embargo, dado que esta flecha azul se encuentra directamente frente a la vista
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de escena, no puede hacer clic y arrastrarla. En su lugar, debe seguir uno de los siguientes
enfoques:

e Haga clicy arrastre la flecha azul en la vista superior o en la vista lateral. Si arrastra la capa
mas cerca de la punta del cono de la camara, se acercara a la cdmara y se mostrara mas
grande. Si la arrastra desde la punta del cono de la cdmara, estard mas atras y se mostrara
mas pequena.

Top View =%

* Rote el punto de vista de la vista de escena manteniendo pulsadas las teclas Ctrl + Mayus
(Windows) o mayusculas + 8 (macQOS) y, a continuacidn, haciendo clic y arrastrando la
vista. Cuando la vista de escena se encuentre en cualquier angulo que no sea el
predeterminado, podra hacer clicy arrastrar la flecha azul, y mover la capa a través del eje z.

Al arrastrar el elemento por el espacio 3D, la posicidn del elemento también se actualizard en las
otras vistas.
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Importacion de modelos 3D

Puede integrar modelos 3D en el proyecto importandolos en la libreria y, a continuacion, arrastrandolos y
colocandolos en los paneles donde sean necesarios. Cada proyecto de Storyboard Pro tiene su propia libreria
de modelos 3D. Como cada instancia del modelo proviene de la libreria del proyecto, Storyboard Pro no tiene
que almacenar una copia del modelo para cada panel que lo utilice.

Storyboard Pro admite los siguientes tipos de modelos 3D:

¢ Filmbox (.fbx)

3DS Max (.3ds)
¢ Wavefront OBJ (.obj)

¢ Allembic (.abc)

Collada (.dae)

NOTA

Se recomienda utilizar el formato Filmbox (.fbx), ya que se puede empaquetar con texturas
integradas en el modelo.

Importacion de un objeto 3D en la libreria

1. En la vista de libreria, haga clic con el botén derecho en la carpeta de la libreria de modelos 3D y
seleccione Import Files (Importar archivos).

2. Enel buscador de archivos, localice y seleccione el modelo 3D y haga clic en Open (Abrir).

Aparece el siguiente aviso.

Si lo desea, puede importar el modelo en su formato original. Sin embargo, si lo convierte a FBX, se
asegurara de que sus texturas se consoliden con el modelo del proyecto.

3. Hagaclicen OK (Aceptar).

El modelo seleccionado aparece en la carpeta de modelos 3D de la vista de libreria.
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4. Arrastre y coloque el modelo 3D de la vista de libreria a la vista de escena o de camara:

» Parainsertarlo entre dos capas especificas, coldoquelo entre esas capas en el panel Layer
(Capa) de la vista de escena o de camara.

» Sidesea insertarlo sobre todas las demas capas, puede colocarlo directamente en la vista de

escena o de camara.

El modelo 3D se inserta en el panel con su tamaio original y en el centro de la escena. Se afade
una capa para el modelo 3D a la lista de capas.

NOTA

Si elimina un modelo 3D de la biblioteca, se eliminaran del proyecto todas las instancias de

ese modelo.

Manipulacion de objetos 3D

Si selecciona un modelo 3D con la herramienta Layer Transform (Transformacién de capa) .1, aparecera un
manipulador de transformacién 3D sobre el modelo en las vistas de escena, camara, superior y lateral. El
manipulador de transformacion para modelos 3D es un cubo con controles para mover, rotar y escalar el

modelo sobre cualquiera de los tres ejes.

Un modelo 3D que se acaba de importar en un panel estara orientado a la cdmara. En consecuencia, el cubo de
su manipulador 3D también estara orientado a la cdmara, lo que le proporcionara un aspecto de cuadrado. En
este angulo, no podra mover ni escalar el modelo sobre el eje z. Para solucionarlo, debe rotar la vista de
escena, utilizar las vistas superior o lateral, o rotar el propio modelo.

El modelo y el manipulador 3D El modelo y el manipulador 3D se ven
estdn orientados al punto de vista. desde un dngulo.
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Rotacion de la vista de escena en 3D

1. Realice una de las siguientes acciones:

e En la barra de herramientas de herramientas, haga doble clic en la herramienta Hand (Mano)
&) y seleccione la herramienta 3D Navigation (Navegacién 3D) €.

» Mantenga pulsado Ctrl + Mayus (Windows) o mayusculas + 8 (macOS).

2. Haga clicy arrastre el interior de la vista de escena para rotarlo en todas las direcciones.

Manipulacion de un objeto 3D

1. Enla barra de herramientas de herramientas, seleccione la herramienta Layer Transform
(Transformacidén de capas) i1.

2. Seleccione el modelo 3D que desea manipular.

3. Enlas vistas de escena, cdmara, superior o lateral, realice una de las siguientes acciones:

I Mover sobre el eje y I

I Mover lateralmente

Mover sobre el eje x I

I Mover sobre el eje z

e Para trasladar el modelo al eje x, haga clic y arrastre la flecha roja.
» Paratrasladar el modelo al eje y, haga clic y arrastre la flecha verde.
e Para trasladar el modelo al eje z, haga clic y arrastre la flecha azul.

» Para trasladar el modelo lateralmente en relacidn con su punto de vista, haga clic y arrastre
su geometria.
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Rotar sobreeleje z I

[ Rotar sobre el eje x

[ Rotar sobre el eje \,rr

Para rotar el modelo sobre el eje x, haga clicy arrastre el circulo rojo.

Rotarentodas las
direcciones

Para rotar el modelo sobre el eje y, haga clic y arrastre el circulo verde.

Para rotar el modelo sobre el eje z, haga clic y arrastre el circulo azul.

Para rotar el modelo en cualquier direccidon, haga clic y arrastre sobre su circulo externo.

Escalar sobre
todos los ejes

[ Escalar sobreel gjey

Escalar sobre
eleje x

Para escalar el modelo sobre el eje x, haga clic y arrastre sobre el punto cuadrado rojo.

Para escalar el modelo sobre el eje y, haga clic y arrastre sobre el punto cuadrado verde.

Para escalar el modelo sobre el eje z, haga clic y arrastre sobre el punto cuadrado azul.

Para escalar el modelo sobre todos los ejes, haga clic y arrastre cualquier vértice del cubo.
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_‘Q'. CONSEJO

Si necesita rotar o escalar el modelo 3D desde un punto pivote especifico, puede mover
el punto pivote del modelo 3D haciendo clic y arrastrando el pivote @& del centro del
manipulador. El manipulador y su pivote se moveran, pero no el modelo.

Vista previa de escenas 3D

En Storyboard Pro, la vista de escena es la vista predeterminada para dibujar y manipular objetos. Sin
embargo, cuando se trabaja en 3D, se presenta una dificultad: al panear, rotar, acercar o alejar la vista de
escena, cambiara el punto de vista desde el que mira la escena. Esto significa que es posible que la posicién
aparente y el tamafio de los elementos no sean representativos de lo que aparecera en el storyboard o la
animatica.

Si desea ver una escena 3D exactamente tal y como se vera en el storyboard, debe utilizar la vista de camara.
La vista de cdmara siempre muestra la escena desde el punto de vista de la cdmara, incluso si la panea, la rota
o la acerca o aleja. Por lo tanto, siempre se debe obtener una vista previa de la escena desde la vista de
camara si se realizan cambios en la posicidn de la cdmara o de los objetos 3D para asegurarse de que la
composicion de la escena sea la esperada.

#EE E 0BT e

Lz vista de cémara conserva Lz composicidn de Lz escena desde el punto de vista de La cdmarz, incluso si realiza acciones como amplizr, panear o rotar.
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O O O E e ee [

En Lz vista de escena, acciones como ampliar o alejar Lz imagen, o panear un poco la vistz pueden afectar a Lz composicidn zparente de Lz escena.

Adicion de la vista de camara al espacio de trabajo

1. Realice una de las siguientes acciones:

* En la esquina superior derecha de la vista de escena, haga clic en el botén £= Add View
(Agregar vista) y, a continuacién, seleccione Camera View (Vista de camara).

* En el mend superior, seleccione Windows > Camera View (Ventanas > Vista de camara).
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Capitulo 16: Creacion e importacion de plantillas

Una plantilla es una copia que realiza el usuario de una o varias capas, o de uno o varios paneles, en una
libreria. Una vez que haya creado una plantilla, puede volver a importarla tantas veces como necesite, ya sea
en el mismo proyecto o en un proyecto diferente.

NOTA

Al crear una plantilla, no estd vinculada al proyecto original. Se crea una copia de los recursos para
la plantilla y puede modificar el proyecto original sin que afecte a la plantilla. Del mismo modo, al
importar una plantilla en el proyecto, se copia en el mismo. La realizacién de cambios en la
plantilla no afectara a las copias importadas y puede realizar cambios en los recursos importados
sin que ello afecte a la plantilla.

Creacion de plantillas de capas

Puede crear una plantilla de una o varias capas desde el panel Layer (Capa) en la vista de escena o de camara.

Creacion de una plantilla de una o varias capas utilizando la vista de escena o de
camara

1. En la vista de libreria, seleccione una carpeta en la que desee almacenar la plantilla.

2. Enel panel de capas de la vista de escena o de camara, seleccione una o varias capas. Para
seleccionar varias capas, realice una de las siguientes acciones:

» Mientras mantiene pulsada la tecla Mayus, haga clic en la primera capa que desee agregar a
la seleccidn vy, a continuacidn, en la Ultima capa que desee agregar. Todas las capas
intermedias formaran parte de la seleccidn.

e Mientras mantiene pulsada la tecla Ctrl (Windows) o 8 (macOS), haga clic en cada capa
que desee agregar a la seleccion.

3. Arrastre y coloque la seleccidon en el panel derecho de la vista de libreria.

4. En el cuadro de didlogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantilla.
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NOTA

También puede cambiar el nombre de una plantilla después de crearla haciendo clic con el
botdn derecho sobre ella y seleccionando Rename (Cambiar nombre).

Importacion de plantillas de capas

Puede importar una plantilla de capas en un panel utilizando la vista de escena o de camara.

Importacion de capas de una plantilla en un panel

1. En lavista de imagenes en miniatura o de linea de tiempo, seleccione el panel en el que desea
insertar la plantilla.

2. Enlavista de libreria, seleccione la plantilla que desea importar.

3. Arrastre y coloque la plantilla en la vista de escena o de camara:

» Parainsertarlo entre dos capas especificas, coldquelo entre esas capas en el panel Layer
(Capa) de la vista de escena o de cdmara.

» Sidesea insertarlo sobre las demds capas, puede colocarlo directamente en la vista de

escena o de camara.

Creacion de plantillas de paneles

Puede crear una plantilla de uno o varios paneles utilizando la vista de imagenes en miniatura o de linea de
tiempo.

Creacion de una plantilla de uno o varios paneles mediante la vista de imagenes en
miniatura

1. En la vista de libreria, seleccione una carpeta en la que desee almacenar la plantilla.
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2. En la vista de imdgenes en miniatura, seleccione uno o varios paneles. Para seleccionar varios
paneles, realice una de las siguientes acciones:

* Mientras mantiene pulsada la tecla Ctrl (Windows) o 8 (macOS), haga clic en cada panel
gue desee agregar a la seleccion.

» Mientras mantiene pulsada la tecla Mayus, haga clic en el primer panel que desee agregar a
la seleccidn y, a continuacidn, en el ultimo panel que desee agregar. Los dos paneles en los
gue ha hecho clic y todos los paneles intermedios se agregardn a la seleccién.

3. Hagaclicy arrastre el controlador de arrastrar y colocar :: de uno de los paneles seleccionados vy, a
continuacion, coloque la seleccidn en el panel derecho de la vista de libreria.

4. En el cuadro de dialogo Rename (Cambiar nombre), cambie el nombre de la nueva plantilla.

NOTA

También puede cambiar el nombre de una plantilla después de crearla haciendo clic con el
botdn derecho sobre ella y seleccionando Rename (Cambiar nombre).

Creacion de una plantilla de uno o varios paneles mediante la vista de linea de tiempo
1. En la vista de libreria, seleccione una carpeta en la que desee almacenar la plantilla.

2. En lavista de linea de tiempo, seleccione uno o varios paneles. Para seleccionar varios paneles,
realice una de las siguientes acciones:
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¢ Mientras mantiene pulsada la tecla Ctrl (Windows) o 8 (macOS), haga clic en cada panel

que desee agregar a la seleccion.

» Mientras mantiene pulsada la tecla Mayus, haga clic en el primer panel que desee agregar a
la seleccidn vy, a continuacién, en el Ultimo panel que desee agregar. Los dos paneles en los
gue ha hecho clic y todos los paneles intermedios se agregaran a la seleccién.

3. Arrastre y coloque los paneles seleccionados en el panel derecho de la vista de libreria.

4. En el cuadro de didlogo Rename (Cambiar nombre), introduzca el nombre de la nueva plantilla.

NOTA

También puede cambiar el nombre de una plantilla después de crearla haciendo clic con el
botdn derecho sobre ella y seleccionando Rename (Cambiar nombre).

Importacion de plantillas de paneles

Puede importar una plantilla de panel en la vista de imagenes en miniatura o de linea de tiempo.

Insercidn de una plantilla de paneles entre dos paneles en la vista de imagenes en
miniatura

1. En la vista de libreria, seleccione la plantilla que desea importar.

2. Arrastre y coloque la plantilla seleccionada en la vista de imdgenes en miniatura, entre los dos

paneles en los que desee que se inserte.
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NOTA

Si estd insertando la plantilla entre dos escenas, puede elegir si el panel se adjuntara a la
escena anterior o a la siguiente, o si se insertara en su propia escena. Esto dependera de lo
cerca que esté de cada escena o del espacio entre ellas en el que coloque la plantilla. A
medida que mueva el panel en el espacio, una linea roja indicarad donde terminara el panel.

El panel se movera al final El panel se movera al comienzo
de la escena anterior de la siguiente escena

I El panel se insertara en su propia escena I

Insercion de una plantilla de paneles entre dos paneles en la vista de linea de tiempo
1. En la vista de libreria, seleccione la plantilla que desea importar.

2. Arrastre la plantilla seleccionada en la vista de linea de tiempo, entre los dos paneles en los que

desea que se inserte.

117



Capitulo 16: Creacién e importacién de plantillas

NOTA

RR_Line 10_Celna _

Si estd insertando la plantilla entre dos escenas, puede elegir si el panel se adjuntara a la
escena anterior o a la siguiente, o si se insertara en su propia escena. Esto dependerd de lo
cerca que esté de cada escena en la que coloque la plantilla. A medida que mueva el panel
cerca de la junta entre las escenas, un corchete verde indicard dénde terminara el panel.

El panel se movera al final de
la escena anterior

El panel se insertara en su
propia escena

El panel se movera al comienzo
de la siguiente escena
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Capitulo 17: Exportacion del proyecto

Una vez que haya terminado el storyboard o la animatica, puede exportarlo para pasar a la siguiente fase de la
produccién.

Si se fija en el menu superior File > Export (Archivo > Exportar), vera que existen muchas formas de exportar
el proyecto. En este capitulo se presentaran los tres tipos de exportacién que mas se utilizan:

* PDF: Al exportar el storyboard como un formato de documento portatil (.pdf), se crea un documento
que contiene un storyboard de animacidn tradicional que presenta cada panel en orden cronoldgico, con
sus nUimeros de escena y panel, asi como sus cuadros de texto. En este formato, puede imprimirlo o
compartirlo digitalmente, y se puede usar como referencia o como material de presentacion.

* Movie (Pelicula): Al exportar la animatica como una pelicula, puede compartirla con los colaboradores
del proyecto e importarla en un software de terceros.

* Harmony: Puede exportar cada escena de la animatica en escenas independientes de Toon Boom
Harmony, con los paneles insertados en las escenas para que se puedan usar como referencia para
crear la animacién. Si tiene la intencién de crear la animacidn en Storyboard Pro, esta accidn permite
pasar rapidamente la produccion de la fase de creacion de storyboard a la animacion.

Exportacidon de un PDF

La exportacidon de un PDF creard un storyboard de animacion tradicional que muestra los paneles junto con su
numero de escena y panel, y sus cuadros de texto.

NOTA

Para visualizar un archivo PDF se requiere un lector de PDF, como Adobe Reader, que puede
descargar de la siguiente pagina: https://get.adobe.com/reader/

Exportacién de un PDF

1. En el mend superior, seleccione File > Export > PDF (Archivo > Exportar > PDF).

Se abre el cuadro de didlogo Export to PDF (Exportar a PDF).
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En la seccién Destination Path (Ruta de destino), haga clic en el botdn Browse (Examinar) 77.

En el cuadro de didlogo Save (Guardar), examine la ubicacion a la que desee exportar el documento
PDF. En el campo File name (Nombre de archivo), escriba el nombre deseado para el documento y
haga clic en Save (Guardar).

En la seccién PDF Export Parameters (Parametros de exportacién de PDF), seleccione un layout
para el archivo PDF.

En la seccion Export Range (Intervalo de exportacion), seleccione si desea exportar todo el
proyecto o solo partes especificas:
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e All (Todo): Exporta el storyboard completo.

» Selected Scenes (Escenas seleccionadas): Seleccione esta opcidn para exportar una
seleccidn especifica de escenas. A continuacion, haga clic en el botdn Select (Seleccionar)
para abrir el cuadro de didlogo Scenes Picker (Selector de escenas), en el que puede:

» Escriba el nimero de una secuencia o de una escena en los campos Sequence
(Secuencia) o Scene (Escena) de la seccidn Filter (Filtrar) para que se muestren
Unicamente las secuencias o escenas de la lista que coincidan.

* Haga clicy arrastre para seleccionar un rango de escenas.

¢ Mantenga pulsada la tecla Ctrl y haga clic en cada escena que desee agregar a la
seleccion.

» Mantenga pulsada la tecla MayUs vy, a continuacion, haga clic en la primera y en la
ultima escena que desee agregar a la seleccion para seleccionar cada escena que
haya entre esas dos, ambas incluidas.

* Sjel proyecto tiene secuencias, haga clic en una secuencia para seleccionar cada
escena de dicha secuencia.

e Current Scene (Escena actual): Exporta solo la escena seleccionada.
e Current Panel (Panel actual): Exporta solo el panel seleccionado actualmente.

» Tracked Panels (Paneles de seguimiento): Exporta paneles en los que estd habilitado el
control de cambios.

6. Sidesea ver el storyboard después de haberlo exportado, active la opcién Open document after
export (Abrir documento tras exportacion).

7. Haga clic en el botén Export (Exportar).

Exportacidn de una pelicula

Una vez que haya creado el storyboard y la animatica, puede exportarlos como un archivo de pelicula para
compartirlos con los colaboradores del proyecto o importarlos en un software de terceros. Puede exportar la
animatica como un archivo de video con audio o como una secuencia de archivos de imagen. Esta ultima se
puede ensamblar en Harmony o en un software de terceros.

Exportacién de una pelicula

1. En el mend superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to Movie (Exportar a pelicula).
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Movie Options

ExportRange  Burn-In  Camera Grids = Captions

Export Close

En la seccién Destination Path (Ruta de destino), haga clic en el botdn Browse (Examinar) 77 y
elija la carpeta en la que desee guardar los archivos exportados.

En el campo File Pattern (Patrén de archivo), escriba un prefijo para los archivos exportados si
tiene previsto exportar una secuencia de imagenes.

En la seccion Export Movie Format (Exportar formato de pelicula), configure las siguientes

opciones:
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a. En la lista desplegable Movie Format (Formato de pelicula), seleccione un formato de
exportacion:

* QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de
exportacion predeterminado que se recomienda por su portabilidad y porque le
permite elegir entre varios cédecs de video.

NOTAS
¢ En Windows, se debe instalar QuickTime de Apple para que

Storyboard Pro pueda exportar peliculas de QuickTime. Puede
configurar que las peliculas de QuickTime utilicen cualquier cédec
compatible con QuickTime, incluidos H.264, MPEG-4 y Animation,
para su exportacion.

¢ En macOS, Storyboard Pro utiliza Apple AVFoundation para exportar
peliculas de QuickTime, lo que le permite utilizar cédecs como H.264,
Apple ProRes 422 y Apple ProRes 4444,

» Sidesea exportar una pelicula de QuickTime con transparencia,
asegurese de elegir un cddec que admita la codificaciéon con un canal
alfa.

» H.264/MPEG-4 (*.mov): formato de pelicula sencillo que utiliza el cédec H.264
compatible con la mayoria de navegadores web.

NOTAS

¢ Eluso de este formato no requiere software adicional. Sin embargo, si
es la primera vez que exporta una pelicula en formato H.264/MPEG-4,
se le solicitard que descargue la libreria OpenH264 de Cisco.
Simplemente haga clic en Yes (Si) cuando se le solicite y Storyboard
Pro descargara la libreria automaticamente y, a continuacion,
exportara la pelicula.

* No hay opciones de codificacion para este formato.

¢ Este formato admite resoluciones de hasta 4096x2304. Cada
dimensién debe ser un multiplo de 16 pixeles.

» El audio exportado en este formato estd codificado en PCM estéreo de
16 bits y 22,05 kHz.

¢ Windows Media Video (*.wmv): formato nativo para Windows Media Player.
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NOTAS

¢ Los archivos Windows Media Video (.wmv) solo se pueden exportar
en Windows.

» Losreproductores de video y editores en sistemas que no sean de
Windows normalmente no pueden abrir archivos Windows Media
Video (.wmv).

e Flash (.swf)

e Secuencia de imagen en formato Jpeg (*.jpg), Targa (*.tga) o Portable Network
Graphics (*.png).

b. LaopciénTransparent Background (Fondo transparente) solo estd disponible para los
formatos QuickTime Movie (.mov), Targa (.tga) y Portable Network Graphic (.png). Active
esta casilla si desea exportar su pelicula o secuencia de imagenes con un fondo
transparente.

c. Enla lista desplegable Resolution (Resolucion), seleccione si desea que la pelicula
exportada tenga el tamano Full Size (Tamafo completo), Half Size (Tamaho de mitad) o
Quarter Size (Tamafio de cuarto) en relacién con la resolucién del proyecto. Se recomienda
exportar la animatica en tamafio completo, a menos que desee exportar rapidamente un
video de prueba.

d. En el ment desplegable Colour Space (Espacio de color), seleccione un espacio de color
diferente en el que desee exportar la pelicula, o permanezca en Project Working Colour
Space (Espacio de color de trabajo del proyecto) predeterminado.

e. Enla lista desplegable One Clip (Un clip), seleccione cdmo desea que se separen los clips
de video:

» Per Scene (Por escena): Crear un archivo de pelicula para cada escena del proyecto.

» Per Sequence (Por secuencia): Crear un archivo de pelicula para cada secuencia del
proyecto, si la hubiera.

» Per Project (Por proyecto): Exportar toda la animatica en un solo archivo de video.

5. En la seccidn Export Range (Intervalo de exportacién), seleccione si desea exportar todo el
proyecto o solo partes especificas:

e Al (Todo): Exporta el storyboard completo.

» Selected Scenes (Escenas seleccionadas): Seleccione esta opcidn para exportar una
seleccidn especifica de escenas. A continuacidn, haga clic en el botdn Select (Seleccionar)
para abrir el cuadro de dialogo Scenes Picker (Selector de escenas), en el que puede:
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» Escriba el nimero de una secuencia o de una escena en los campos Sequence
(Secuencia) o Scene (Escena) de la seccidn Filter (Filtrar) para que se muestren
unicamente las secuencias o escenas de la lista que coincidan.

e Haga clicy arrastre para seleccionar un rango de escenas.

* Mantenga pulsada la tecla Ctrl y haga clic en cada escena que desee agregar a la
seleccion.

* Mantenga pulsada la tecla Mayus vy, a continuacion, haga clic en la primera y en la
ultima escena que desee agregar a la seleccidn para seleccionar cada escena que
haya entre esas dos, ambas incluidas.

* Sjel proyecto tiene secuencias, haga clic en una secuencia para seleccionar cada
escena de dicha secuencia.

¢ Current Scene (Escena actual): Exporta solo la escena seleccionada.
e Current Panel (Panel actual): Exporta solo el panel seleccionado actualmente.

» Tracked Panels (Paneles de seguimiento): Exporta paneles en los que estd habilitado el
control de cambios.

6. Sidesea reproducir automaticamente el video o ver los archivos exportados una vez realizada la
exportacion, active la opcién Open document/folder after export (Abrir documento/carpeta tras
exportacion).

7. Haga clic en el botdn Export (Exportar).

Exportacion a Harmony

Storyboard Pro puede exportar automaticamente cada escena del proyecto en una escena que se puede abrir
en Harmony, donde puede utilizar la animatica para crear y programar la animacion. Las escenas de Harmony
resultantes tendran la misma longitud que las escenas del proyecto de Storyboard Pro. Contendran cada uno
de sus paneles para que pueda animar sobre ellos, y contendran su parte correspondiente de la pista de
sonido de la animatica.

Exportacion de escenas de Harmony

1. En el mend superior, seleccione File > Export > Export to Harmony (Archivo > Exportar > Exportar
a Harmony).

125



Capitulo 17: Exportacién del proyecto

Se abre el cuadro de didlogo Export to Harmony (Exportar a Harmony).

ExportRange = Sgunds  Burn-In

O

2. En la seccién Destination Path (Ruta de destino), haga clic en el botdn Browse (Examinar) 77 y
elija la carpeta en la que desee guardar los archivos exportados.

3. Enel campo File Pattern (Patrén de archivo), escriba un prefijo para los archivos exportados si
tiene previsto exportar una secuencia de imagenes.

4. En lalista desplegable Format (Formato), seleccione una de las siguientes opciones:

* Harmony Offline (Harmony sin conexidn): Creara escenas que se pueden abrir en Harmony
Stand Alone.

* Harmony Database (Base de datos de Harmony): Creara un paquete de escenas que se
puede importar en una base de datos de Harmony Server.

5. Seleccione uno de los siguientes tipos de exportacion dependiendo de la herramienta con la que
prefiera trabajar.

* Rendered Animatic (Animatica renderizada): Renderiza la animatica en una secuencia de
imagenes de mapa de bits agrupadas en las escenas de Harmony exportadas. Asi se
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garantiza que el contenido de la animatica se renderice con precisién en Harmony, sobre
todo si tiene la intencion de utilizar una versidn anterior.

» Escena original: Exporta la animatica directamente en escenas de Harmony sin renderizarla.
Asi se conservan las capas, dibujos y movimientos de la cdmara para que se puedan utilizar
en Harmony.

6. En la seccidn Export Range (Intervalo de exportacidn), seleccione si desea exportar todo el
proyecto o solo partes especificas:

7. Sidesea ver los archivos exportados una vez realizada la exportacidn, active la casilla de
verificacion Open document/folder after export (Abrir documento/carpeta tras exportacidn).

8. Haga clic en Export (Exportar).
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